
 

 

 

 

 

 

 

How-To Guide 

SAP NetWeaver 

Document Version: 1.0 - 2025-10-15 

 

How To... Configure CM Services in SAP NetWeaver 
7.3 and up 
 



  

How To... Configure CM Services in SAP NetWeaver 7.3   

Scenario  © 2025 SAP AG or an SAP affiliate company. All rights reserved. 2 

Document History 

Document Version Description 

1.0 First official release of this guide 

 

 



  

How To... Configure CM Services in SAP NetWeaver 7.3   

Scenario  © 2025 SAP AG or an SAP affiliate company. All rights reserved. 3 

Table of Contents 
1 Scenario .............................................................................................................................................. 5 

2 Background Information .................................................................................................................... 6 

3 Prerequisites ....................................................................................................................................... 7 

4 Introduction ........................................................................................................................................ 8 
4.1 Landscape Options ....................................................................................................................... 10 

4.1.1 Deployable Export ........................................................................................................... 11 
4.1.2 Deployable Export - Software Components ................................................................. 11 
4.1.3 Source Export ................................................................................................................. 14 

5 Recommendations & Restrictions ....................................................................................................16 

6 Initial Setup and Configuration of CM Services ................................................................................19 
6.1 Assumptions ................................................................................................................................. 19 
6.2 Configuring SLD ............................................................................................................................ 20 
6.3 Configuring NWDI with CM Services ........................................................................................... 22 
6.4 Mapping Roles in UME .................................................................................................................. 24 
6.5 Required Connections .................................................................................................................. 25 
6.6 Configuring the CM Services Server ........................................................................................... 26 

6.6.1 Creating a User for RFC Destinations from CTS System to CM Services ................ 26 
6.6.2 Creating an RFC Destination from CM Services to CTS ............................................. 28 

6.7 Configuring the CTS System ....................................................................................................... 30 
6.7.1 Creating a Developer User............................................................................................. 30 
6.7.2 Configuring RFC Destination and Logical Ports .......................................................... 32 
6.7.3 Activate Services in SICF ............................................................................................... 43 

7 System Landscape Configuration .................................................................................................... 44 

7.1 Creating a Non-ABAP System with Development Configuration ............................................. 45 
7.1.1 Adapting TMS parameters ............................................................................................ 48 
7.1.2 Configuring the Development Configuration ............................................................... 50 
7.1.3 Get the required Software Component Archives ........................................................ 54 

7.2 Creating Target Systems ............................................................................................................. 57 
7.3 Creating Transport Routes ......................................................................................................... 60 

8 Development and Export Process .................................................................................................... 63 
8.1 Import Development Configuration ............................................................................................ 63 
8.2 Release Activity ............................................................................................................................. 67 
8.3 Complex Example ......................................................................................................................... 72 
8.4 SCA Export and Transport ........................................................................................................... 74 

9 Troubleshooting.................................................................................................................................81 

9.1 Error during Import / Deployment (RC 12) ................................................................................ 81 
9.2 Import seems to run forever ........................................................................................................ 82 
9.3 Activity cannot be released .......................................................................................................... 83 

10 Appendix ........................................................................................................................................... 83 
10.1 Using the Transport Organizer Web UI ....................................................................................... 83 
10.2 Importing a Transport Request ................................................................................................... 84 
10.3 Extending the Landscape ............................................................................................................. 87 
10.4 Configure Users on CM Services server ..................................................................................... 88 
10.5 Using Build Options ...................................................................................................................... 88 
10.6 Checking Role SAP_CTS_PLUS ................................................................................................... 89 
10.7 SIDs in CM Services ...................................................................................................................... 92 
10.8 Creating a new SC ......................................................................................................................... 92 



  

How To... Configure CM Services in SAP NetWeaver 7.3   

Scenario  © 2025 SAP AG or an SAP affiliate company. All rights reserved. 4 

10.9 Enable existing non-ABAP system for CM Services .................................................................. 95 
10.10 Deleting a system with Development Configuration ................................................................. 99 

 



  

How To... Configure CM Services in SAP NetWeaver 7.3   

Scenario  © 2025 SAP AG or an SAP affiliate company. All rights reserved. 5 

1 Scenario 
A while ago, the Change and Transport System of ABAP (CTS) has been enhanced so that it can be 
used for transporting non-ABAP objects as well (enhanced CTS, also known as CTS+). In the remainder 
of this document, the abbreviation CTS is used for the system where the transport landscapes are 
configured and for the fact that CTS can also be used for non-ABAP transports. 

In Change Management Service (CMS) of NWDI you have to basically perform two tasks when you 
configure a track: The first task can be considered as the system administration part where you setup a 
transport landscape for your runtime systems (AS Java). The second task is the configuration of so-called 
development configurations for your development cycle. Later on, you use the development configuration 
in the SAP NetWeaver Developer Studio (NWDS) to develop your software and the CMS to assemble 
and transport deployable units (SCA files – Software Component Archives). The integration with CTS is 
possible during the assembly step where the SCA file is attached to a CTS transport request. In this 
scenario, a track configuration is still needed. 

With the introduction of CTS and CM Services these tasks are separated. The first task is covered by 
CTS, where you define your non-ABAP runtime systems and your transport route. The remaining second 
part – development configurations and export - is handled by CM Services. Therefore a CMS track in 
NWDI is not needed. With the close integration of CM Services into the mechanism of the CTS you can 
manage your development configurations together with your transport landscape using the CTS system. 

Note 

Of course it is still possible to use NWDI with CMS with or without CTS integration also in 
parallel to CM Services. 

Check note 1775838 ‘CMS / CM Services: What to use in which scenario?’ for details on the 
options and on what to use when. 
Details about CMS and CM Services, similarities and differences are explained in a blog on 
SCN: 
http://scn.sap.com/blogs/cms_cm_services_similarities_and_differences/2013/05/29/similarit
ies-and-differences-in-cms-and-cm-services 

With CM Services two scenarios are possible. You can transport sources or you can transport 
deployables. Deployables are files (SCAs or SDAs) that can be deployed to an AS Java with the help of 
SDM or Deploy Controller (as of SAP NetWeaver 7.10). After the deployment, the new functionality can 
be used on the system – no built is required on this system. 

When setting up your landscape you need to decide what you would like to transport along that transport 
route – sources or deployables. In both cases you can choose on which level of granularity you would like 
to transport. For the transport of sources, you can transport source changes on a small granular level 
which is called Activity transport or you can transport complete software components (SCAs). For a 
landscape that is configured for transporting deployable units, you have the option to transport SDAs 
based on small source changes - the Activities - , single development components (SDAs) or complete 
Software components (SCAs). 

The export of SDA-based activities and the transport of activities on source level are triggered directly 
from within the NWDS via the Transport View in the Development Configuration Perspective. When 
releasing an activity the system either evaluates all the runtime objects (SDAs) that belong to the activity 
and includes them in the transport request in CTS or the sources are exported and attached to a transport 
request. The file format of the attached activity-based package is called *.dip (Development Infrastructure 
Package) in both cases. To import the transport requests, the methods and tools of CTS are used. 

Another option is to use the DI Export Service UI to export SCAs or SDAs. During the export the SCA or 
SDA files are attached to a CTS transport request. Imports are again done via the Transport Management 
System (TMS) on the CTS system. 

To set up a landscape for deployable transport, a development configuration is needed only for your 
development system. All other systems in your landscape of runtime systems are pure deploy-targets. 

In addition the transport of single Development Components (SDAs) is possible via the DI Export Service 
UI. But this is designed for experts only and should be used with care. You need to make sure to 
transport in a consistent way. When using the SDA export via the Export Service Web UI, dependencies 
are not taken into consideration. Only the SDA that you chose will be attached to a transport request. 

http://service.sap.com/sap/support/notes/1775838
http://scn.sap.com/blogs/cms_cm_services_similarities_and_differences/2013/05/29/similarities-and-differences-in-cms-and-cm-services
http://scn.sap.com/blogs/cms_cm_services_similarities_and_differences/2013/05/29/similarities-and-differences-in-cms-and-cm-services
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If you transport deployables, only the runtime system and the CTS system are needed when executing an 
import. The NWDI system can be down. 

Transporting sources through the system landscape requires a development configuration (with DTR 
workspaces and CBS buildspace) for each target system that is part of the transport route in your 
landscape, as well. The import process for sources triggers a rebuild within the CBS buildspace of the 
target system. The SDAs that are affected by the changed sources will be re-built and deployed to the 
target runtime system. The import is started from the import queue of your target system on the CTS 
system. This process is in most cases much quicker than transporting the whole software component 
(SCA) if there are just small changes on an upper level. But if your change is done in a very basic 
development component that is used by many other development components, a re-build for all the 
dependent development components will be done. In that case, the transport of activities might not speed 
up the process. A combination of both options – transporting activities and SCAs on a source level might 
make sense. If you decide to use the transport of sources, the NWDI system has to be available while 
executing the import (the sources need to be integrated, a build has to be triggered). 

 CAUTION 

Keep in mind that as a consequence of the source transport, sources are available in the 
corresponding DTR workspaces for all systems of your landscape – even for the productive 
system. Therefore you should set ACLs for these workspaces to prevent an accidental 
source change by your developers. For more details take a look at the SAP library 
http://help.sap.com/saphelp_nw73/helpdata/en/c9/d94388f62c8f478eadd4d1902d7101/fram
eset.htm. 

Take a look at chapters Landscape Options and Recommendations and Restrictions to learn more. Read 
these chapters carefully and decide for which option you would like to go before you configure your 
landscape. 

With SAP NetWeaver 7.3, CM Services were further enhanced by new services: Synchronize Service and 
History Service. The Synchronize Service allows you to determine and resolve version differences of 
software components between the runtime system and what is imported into the NWDI. It replaces the 
upload system. This was needed in previous releases to provide the required libraries and the already 
existing source code to your development configuration – and therefore to the respective workspace(s) 
and buildspace(s) and to deploy the files if needed. The History Service provides a quick overview of 
running exports, exports which have been executed, running imports and synchronizations (which are 
shown as imports). 

Moreover, the initial setup has been enhanced by providing a CTC template for the automatic 
configuration of CM Services. 

The main purpose of this guide is to explain how to set up CM Services in SAP NetWeaver 7.3 and make 
your system landscape ready for the use of CM Services release if you start with CM Services on SAP 
NetWeaver 7.3. The required configuration steps to enable the CM Services are described step-by-step. 
The deployable transport is explained for a simple transport landscape and the development process is 
shown in a simple example. We assume that you have a basic knowledge about CTS and NWDI. Hints 
for setting up the source transport are given where it differs from setting up the deployable transport. 

The configuration that you might have done in enhancement packages 1 or 2 for SAP NetWeaver 7.0 is 
still valid. There are no needs to adapt the configuration after an upgrade to SAP NetWeaver 7.3. 
Everything that you configured will still work. But if you would like to use the new functionality, some 
configuration changes might be required - especially, if you were using an upload system up to now and 
would now like to switch to the Synchronize Service. Refer to the chapter Using the Synchronize Service 
for details. 

 

 

2 Background Information 
Documentation about CTS in the SAP Library: 
http://help.sap.com/saphelp_nw73/helpdata/en/bb/6fab6036a146baa58e42fac032ab7b/frameset.htm 

Documentation about CM Services in the SAP Library: 

http://help.sap.com/saphelp_nw73/helpdata/en/84/1fabea09f048c69b48d8e08de38c95/frameset.htm  

http://help.sap.com/saphelp_nw73/helpdata/en/c9/d94388f62c8f478eadd4d1902d7101/frameset.htm
http://help.sap.com/saphelp_nw73/helpdata/en/c9/d94388f62c8f478eadd4d1902d7101/frameset.htm
http://help.sap.com/saphelp_nw73/helpdata/en/bb/6fab6036a146baa58e42fac032ab7b/frameset.htm
http://help.sap.com/saphelp_nw73/helpdata/en/84/1fabea09f048c69b48d8e08de38c95/frameset.htm
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Best Practice Guide for Implementing CTS (does not include CM Services): 
https://www.sdn.sap.com/irj/sdn/go/portal/prtroot/docs/library/uuid/10456aac-44f7-2a10-1fbe-
8b7bcd7bcd58  

Guides for CM Services in different releases on SCN: http://scn.sap.com/docs/DOC-
8576?rid=/webcontent/uuid/c0ce1dd8-c020-2b10-d080-a1cd3e985af1#NWDI  

 

SAP Notes: 

Central SAP Note for CM Services: 1361909 

Central SAP Note for CTS+: 1003674 

Note 1775838 - CMS / CM Services: What to use in which scenario? 

 

3 Prerequisites 
To be able to use CM Services with the functionality described in this guide, your systems have to fulfill 
the following prerequisites: 

• Change and Transport System (CTS): enhancement package 2 SP7 for SAP NetWeaver 7.0 or 
higher 

o SAP NetWeaver Application Server ABAP (AS ABAP) which acts as 
▪ Domain Controller 
▪ Communication System 

o SAP NetWeaver Application Server Java (AS Java) where the Deploy Web Service for 
target systems runs in case the deployable transport is used. 

o Has to support log-in via Single-Sign-On. 

Note 

A CTS system on enhancement package 1 SP7 for SAP NetWeaver 7.0 is possible as well. 
With this release, there is a restriction for the length of some of the fields of the object list. 
More details on object lists are available in the SAP Library: 
http://help.sap.com/saphelp_nw70ehp2/helpdata/en/2b/acde17180f4f26a57a0c777f33d5a4/f
rameset.htm. 
 

• SAP NetWeaver Development Infrastructure (NWDI) on SAP NetWeaver 7.3 or higher with 

the components 

o DTR (Design Time Repository) (Usage Type DI) 

o CBS (Component Build Service) (Usage Type DI) 

o CM Services (Usage Type AS Java) 

o Deploy Web Service for all systems where source transports are used (this includes the 

development system). 

Note 

It is possible but not recommended to use the components DTR and CBS of NWDI on a 
release lower than SAP NetWeaver 7.3. For more details and restrictions see SAP Note 
1361909. 

The NWDI component CMS is still part of the usage type DI installation (NWDI) but not 
needed or used in case your development and transport process is based on CM Services. 
Nevertheless you can use CMS and CM Services in parallel. 

CM Services are part of every AS Java installation (as of enhancement package 1 for SAP 
NetWeaver 7.0). The recommendation is to setup CM Services on the NWDI system. 

 

• SAP NetWeaver Developer Studio (NWDS) on 

o SAP NetWeaver 7.3 or higher 

https://www.sdn.sap.com/irj/sdn/go/portal/prtroot/docs/library/uuid/10456aac-44f7-2a10-1fbe-8b7bcd7bcd58
https://www.sdn.sap.com/irj/sdn/go/portal/prtroot/docs/library/uuid/10456aac-44f7-2a10-1fbe-8b7bcd7bcd58
http://scn.sap.com/docs/DOC-8576?rid=/webcontent/uuid/c0ce1dd8-c020-2b10-d080-a1cd3e985af1#NWDI
http://scn.sap.com/docs/DOC-8576?rid=/webcontent/uuid/c0ce1dd8-c020-2b10-d080-a1cd3e985af1#NWDI
http://service.sap.com/sap/support/notes/1361909
http://service.sap.com/sap/support/notes/1003674
http://service.sap.com/sap/support/notes/1775838
http://help.sap.com/saphelp_nw70ehp2/helpdata/en/2b/acde17180f4f26a57a0c777f33d5a4/frameset.htm
http://help.sap.com/saphelp_nw70ehp2/helpdata/en/2b/acde17180f4f26a57a0c777f33d5a4/frameset.htm
http://service.sap.com/sap/support/notes/1361909
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o SAP NetWeaver Composition Environment 7.20 

o SAP enhancement package 2 for SAP NetWeaver 7.0 or higher. 

o SAP enhancement package 1 for SAP NetWeaver 7.0 SP 10 

o SAP NetWeaver 7.0 SP 25 

 CAUTION 

If you plan to develop e.g. Web Dynpro Java, Business Process Management, Business 
Rules Management, Composite Application Framework or Visual Composer you have to 
make sure that the runtime systems and the NWDS are on the same release and SP level. 
See SAP Note 718949 for details. You can nevertheless use the CM Services of SAP 
NetWeaver 7.3 even if your runtime systems are on a lower release. In that case you need 
an (maybe additional) SAP NetWeaver Developer Studio which supports releasing the 
activities in the transport view. For versions of the developer studio which support releasing 
activities, refer to SAP Note 1361909. 

 

Note 

Further information on using a different NWDI Release compared to Release of Runtime 
System is “also available in a blog on SCN 
http://scn.sap.com/people/marion.schlotte/blog/2005/10/25/jdi-software-vs-jdi-content  

 

• System Landscape Directory (SLD): no special requirements but make sure your SLD content 

is always up to date. If you need more information on how to update your SLD content, take a 

look at note 669669. 

 

• Runtime Systems: no special requirements 

 CAUTION 

If you plan to develop e.g. Web Dynpro Java, Business Process Management, Business 
Rules Management, Composite Application Framework or Visual Composer you have to 
make sure that the runtime systems and the NWDS are on the same release and SP level. 
See SAP Note 718949 for details. You can nevertheless use the CM Services of SAP 
NetWeaver 7.3 even if your runtime systems are on a lower release. In that case you need 
an (maybe additional) SAP NetWeaver Developer Studio which supports releasing the 
activities in the transport view. For versions of the developer studio which support releasing 
activities, refer to SAP Note 1361909. 

Note 

Further information on using a different NWDI Release compared to Release of Runtime 
System is “also available in a blog on SCN 
http://scn.sap.com/people/marion.schlotte/blog/2005/10/25/jdi-software-vs-jdi-content  

 

 

Read the chapters Introduction and Recommendations & Restriction as well for more details. 

Note 

Always check the SAP Note 1361909 for updates on CM Services. 

 

4 Introduction 
Mainly two systems are relevant for configuring the CM Services. You need a system, where NWDI (DTR 
and CBS) is installed and one that can be used to host the transport landscape (CTS system). An SLD is 

http://service.sap.com/sap/support/notes/718949
http://service.sap.com/sap/support/notes/1361909
http://scn.sap.com/people/marion.schlotte/blog/2005/10/25/jdi-software-vs-jdi-content
http://service.sap.com/sap/support/notes/669669
http://service.sap.com/sap/support/notes/718949
http://service.sap.com/sap/support/notes/1361909
http://scn.sap.com/people/marion.schlotte/blog/2005/10/25/jdi-software-vs-jdi-content
http://service.sap.com/sap/support/notes/1361909
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required as well to register the development configurations and to create e.g. Products and Software 
components. 

The following figure shows an overview of the available components on your systems if both NWDI and 
CTS system are on SAP NetWeaver 7.3. 

 

Before starting configuring the CM Services, you should think about the systems that you have and how 
you could use them. One option for the CTS system would be to use the SAP Solution Manager. 

 CAUTION 

Keep in mind that the CTS system has to be on enhancement package 1 SP 7 for SAP 
NetWeaver 7.0 as a basis release. If you are using SAP Solution Manager for CTS, make 
sure that your SAP Solution Manager is using this basis release at least. The SP naming of 
SAP Solution Manager is different from the SAP NetWeaver Support Package level it is 
based on. 

SAP provides CM Services as part of each AS Java. So CM Services and some other components (e.g. 
SLD, Deploy WS) are available on both systems (NWDI and CTS). It is up to you and depends on the 
scenario on which server you want to use CM Services and the Deploy Web Service. Please take a look 
at the chapter Recommendations & Restrictions before you start. 

 CAUTION 

If you decide to transport deployables, you should use the Deploy Web Service on the CTS 
system for all other systems than the development system. For the development system and 
if you would like to transport sources via CM Services you have to use the Deploy Web 
Service on the same system as the CM Services - in that use case you cannot separate 
these two components. Take a look at the chapter Recommendations & Restrictions for 
details. For more Information on the Deploy Web Service, take a look at 
http://help.sap.com/saphelp_nw73/helpdata/en/2b/326d6274134cea8b217f24889d19c1/fra
meset.htm. 

Note 

If you are already using CTS for other scenarios e.g. for transporting objects in a portal 
landscape, you might already have configured a Deploy Web Service. This does not 
influence your decision on where to run the CM Services. The configuration for the Deploy 
Web Service in SM59 can be copied to point to another AS Java – details are described in 
the chapter Configure Logical Ports. 

 

In case you have existing tracks and want to use the features of CM Services for new development 
landscapes, you can use CMS and CM Services in parallel. In both cases DTR is needed to store the 
sources. CBS will build the components and store the archives. The migration from CMS to CM Services 
is described in the guide ‘How To…Switch to CM Services’ at http://scn.sap.com/docs/DOC-16164. 
Details about CMS and CM Services, similarities and differences are explained in a blog on SCN: 

http://help.sap.com/saphelp_nw73/helpdata/en/2b/326d6274134cea8b217f24889d19c1/frameset.htm
http://help.sap.com/saphelp_nw73/helpdata/en/2b/326d6274134cea8b217f24889d19c1/frameset.htm
http://scn.sap.com/docs/DOC-16164
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http://scn.sap.com/blogs/cms_cm_services_similarities_and_differences/2013/05/29/similarities-and-
differences-in-cms-and-cm-services  

This guide will explain step-by-step how to set up CM Services initially, how to set up a system landscape 
for transports with development configurations and how to work with the newly provided features of CM 
Services. 

The configuration steps how to set up CM Services initially are explained in chapter Initial Setup and 
configuration of CM Services. 

In case the CM Services are already enabled in your system landscape, you need to decide which kind of 
landscape option (see chapter Landscape Options) you want to enable. Depending on the scenario, the 
system landscape configuration described in chapter System Landscape Configuration looks different. 

The chapter Development and Export Process focuses on the development and release process and 
explains how to work with development configurations in the NWDS, how to bundle an activity for being 
transported via CTS and how to export a software component archive (SCA) to be attached to a CTS 
transport request with the DI Export Service UI. 

4.1 Landscape Options 

This guide is based on a landscape example with three runtime systems: a Development (DEV), a Test 
(TST) and a Production (PRD) System. 

Depending on the transport scenario, the configuration of your system landscape looks different. The 
main difference is that for source transports a development configuration is needed for your source 
(development) system and each target system in your transport route. For a pure transport of deployables 
a development configuration is needed just for the source/development system. 

In addition you need to decide which level of granularity you would like to use for transports along your 
transport route. Here are the options that you can choose from per development configuration: 

1. Source Export – Granularity: 

a. Software Components  

b. Activities 

2. Deployable Export - Granularity:  

a. Software Components  

b. Development Components 

c. Activities 

The question that you have to ask yourself is ‘What do I like and allow to transport?’ 

Take the following into consideration when you think about the options 

• Use deployable transport whenever possible 
o You only need a development configuration for your development system. 
o You don’t need workspaces and buildspaces on NWDI for your test and production 

system and therefore NWDI must not be up and running during test or production import. 
(if CTS Deploy Web Service is running on different server than NWDI) 

o No-one would by accident use the development configuration for the test or production 
system when developing 

• Use source transport if you have to transport your changes individually as they were done one by 
one and cannot use the DC level as this would mean that several of your changes would be 
transported together (as they concern the same SDA). 

• If you use the transport of sources with Web Dynpro, CAF, BPM, BRM etc., try to make sure that 
sources coming from two different source systems do not meet in one target system. This would 
result in conflicts that you have to solve in the target system. 
 

Note 

It is not recommended to use the SDA Export via the Export Service UI (option 2 b) except if 
you really know what you do. This option is only made for experts. You have to make sure 
that all dependent SDAs that were changed are part of the same transport request or were 
already transported. 

 

http://scn.sap.com/blogs/cms_cm_services_similarities_and_differences/2013/05/29/similarities-and-differences-in-cms-and-cm-services
http://scn.sap.com/blogs/cms_cm_services_similarities_and_differences/2013/05/29/similarities-and-differences-in-cms-and-cm-services
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 CAUTION 

In case you decide to use the source transport, you have to set up each target system with a 
development configuration. It is not possible to have e.g. the DEV system with a 
development configuration, the TST without and the PRD again with a development 
configuration. A so-called mixed scenario concerning development configurations is not 
possible and not supported! 

 

Note 

Both the behavior of the CTS system when asking for a request and what happens after 
having attached a file depend on the transport strategy that you have configured in TMS. It 
is possible to let the system create requests and to make it release them automatically. 
Take a look at the parameters for details: 
http://help.sap.com/saphelp_nw73/helpdata/en/c5/d9012e437d4c318976edc9791f2ae4/fram
eset.htm 

 

Let’s look at the two options in more detail. 

 

4.1.1 Deployable Export 

As of enhancement package 2 for SAP NetWeaver 7.0, you can configure a transport of deployables. A 
development configuration is only required for the development (DEV) system. All other systems in your 
transport route are pure deploy targets. For these systems you only have to make sure that there is the 
Java Deploy URL configured for the deployment. For the deployable transport three transport scenarios 
are possible. You have to configure the Export Mode in the development configuration for your 
development system. The figure below shows the three configuration options explained in the next 
chapters. 

  

4.1.2 Deployable Export - Software Components 

To export and attach SCAs to a transport request the DI Export Service Web UI is used. You can call this 
UI from the Development Configuration UI (see chapter SCA Export and Transport for more details). As a 
first step, you have to choose the system from which you would like to export an SCA – this is usually 
your source/development system. After that, you can choose SCAs from those that are marked as to be 
developed in the respective development configuration. The Export Service UI will guide you through the 
process of adding the SCA to a transport request. For this process, a transport request can be taken 
automatically from the CTS system or you can create one with the help of the Transport Organizer Web 
UI. Also, after having added the SCA to the request, the request can be released automatically or 
manually – this depends on the transport strategy that you have configured in CTS. 

The process for the SCA transport is shown in the following figure: 

http://help.sap.com/saphelp_nw73/helpdata/en/c5/d9012e437d4c318976edc9791f2ae4/frameset.htm
http://help.sap.com/saphelp_nw73/helpdata/en/c5/d9012e437d4c318976edc9791f2ae4/frameset.htm
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Note 

From the developer’s point of view, nothing has changed. You have to import the 
development configuration and synchronize the sources at first. After that, you can start 
developing. Checking in and activating the changes is done in the same way as with CMS. 
You can release the activity, but in case your changes will be transported via SCA export, 
you don’t need to do it explicitly. That means the export process will take all activated 
activities that are related to the software component that is being exported. For activities that 
are listed as ‘Waiting’ in the transport view of the Developer Studio, the export process 
triggers the automatic release. 
In case the developer wants to release the activity, but the development configuration is not 
configured for Deployable Export, an error message as shown in the following figure will be 
displayed. 
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4.1.2.1 Deployable Export - Development Components 

To export and attach SDAs to a transport request the DI Export Web UI is used. You can call this UI from 
the Development Configuration UI (see chapter SCA Export and Transport for details). As a first step, you 
have to choose the system from which you would like to export an SDA – this is usually your 
source/development system. After that, you can choose SDAs from those where the wrapping SCA is 
marked as to be developed in the respective development configuration. The Export Service UI will guide 
you through the process of adding the SDAs to a transport request. The process for the SDA transport is 
shown in the following figure: 

Note 

It is not recommended to use the Export of development components unless you really 
know what you do. This option is only made for experts. You have to make sure that all 
dependent SDAs that were changed are part of the same transport request or were already 
transported. The Export Service UI does not do this for you. There are no warnings or 
checks. 

 

4.1.2.2 Deployable Export - Activities 

The transport of deployables based on activities is triggered by a developer from within the Transport 
View of the SAP NetWeaver Developer Studio. First the developer imports the development configuration 
into his SAP NetWeaver Developer Studio, develops the application, checks-in and activates the Activity. 
These steps remain the same – it doesn’t make any difference if you are using CM Services or CMS or 
whether your landscape is configured for source or deployable transport. When releasing an Activity, you 
will find a new dialog. A transport request from CTS will be provided or you can create a new one with the 
help of the Transport Organizer Web UI (a Web Dynpro ABAP application that runs on the CTS system). 
The system evaluates all development components that are affected by your activity and the respective 
SDA files will be packed in a DIP-file and this will be attached to the transport request. An SDA can either 
become part of a DIP-file because it is directly affected by the activity that is released or because it had to 
be rebuilt because it depends on the changed SDA. With this, the developer has finished his work in the 
developer studio. As a next step, the transport request has to be released. You can do this either with the 
help of the Transport Organizer Web UI or in an automated way. 

Note 

SDAs as deployable units are transported and all systems along the transport route (except 
for the development system) are pure deploy targets without a development configuration. 
This is the smallest granularity for deployable transport that is based on source changes. 

Note 

It might happen that more than one DIP file is attached to your transport request even if you 
release just one activity. The reason for this is that one dip file contains only SDAs 
belonging to one software component. So if your development involves development 
components located in different software components, you will end up with more than one 
DIP. 

Note 

CBS keeps the information about rebuilt DCs for 30 days. Check SAP Note 1909778 (CM 
Services Release of activities to CTS+ not working) in case you expect that there are more 
than 30 days between activating and releasing an activity in your company. 

 

The process for transporting deployables based on activities is shown in the following figure: 

http://service.sap.com/sap/support/notes/1909778
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The runtime objects are deployed into the target system during an import. This ensures consistency in the 
target system. 

 

 

4.1.3 Source Export 

We assume the system landscape with DEV, TST and PRD is set up and configured with a development 
configuration for each system in the transport route. That means your landscape is configured and ready 
for source transport. The steps how to do so are explained in chapter System Landscape Configuration. 

In a landscape like this, you can transport your source changes based on Activities or based on a 
complete Software Component Archive (SCA) as shown in the figure below. 

 
 

4.1.3.1 Source Export - Activities 

The following figure shows an overview of how the process of transporting activities works. Consider this 
as a logical view on the components involved in the process. 
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As a developer the first thing you have to do is to import the development configuration into your SAP 
NetWeaver Developer Studio and to synchronize the sources if you would like to change an existing 
application. 

The first two steps (check-in and activate) after having finished your development in the NWDS remain 
the same – it doesn’t make any difference if you are using CM Services or CMS. During the activation 
process the changes will be deployed to the DEV system. This hasn’t changed compared to the CMS 
behavior. Only when releasing an activity, you will find a new dialog. A transport request from CTS will be 
provided or you can create a new one with the help of the Transport Organizer Web UI. A DIP-file 
containing the changed source files is then attached to the transport request. With this, the developer has 
finished his work in the developer studio. As a next step, the transport request has to be released. You 
can do this either by the help of the Transport Organizer Web UI or in an automated way. 

Note 

In case the developer wants to release the activity, but the development configuration is not 
configured for transporting sources an error message as shown in the following figure will be 
displayed. 
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Now, the transport request is ready for import in the next system – the TST system in our example. You 
can start the import via transaction STMS of the CTS system. If you do so, the sources will become part 
of the inactive workspaces for the TST development configuration in DTR. Then, an activation of the 
changes is done by CBS integrating the sources into the active workspaces. After activation, a rebuild of 
the changed development components and the dependent ones will be done for the TST system in CBS 
and new or changed applications will be deployed to the TST system. The transport request is forwarded 
to the queue of the PRD system. As soon as the import is started for the PRD system, the same process 
as for the test system will be executed – this time for the workspaces and the buildspace of the PRD 
system. 

 

4.1.3.2 Source Export - Software Components 

If you decide to use the SCA transport (with sources) you will use the DI Export Service UI for exporting 
the SCAs. The activities related to the SCA export - listed as ‘Waiting’ in the transport view of the NWDS - 
are released automatically after the export has been done. The process is explained in the chapter SCA 
Export and Transport. 

Note 

Please keep in mind that the usage of the DI Export Service UI is exactly the same for the 
SCA transport with or without sources. The sources of an SCA file will be assembled in both 
cases (physically or via pointer). It depends on the landscape configuration what will happen 
during the import process. In a source transport enabled landscape, the CM Services will 
trigger the DTR workspace update, CBS rebuild and deployment to the target system. In a 
landscape that is configured for deployable transport only, the SCA file will be deployed to 
the target system via the Deploy WS directly. 

 

5 Recommendations & Restrictions 
This chapter covers some recommendations and restrictions but in general you should check the CM 
Services central Note 1361909. 

Check also SAP Note 1775838 ‘CMS / CM Services: What to use in which scenario?’ for details on the 
options and on what to use when. 

Based on your requirements decide if you would like to use CMS with or without CTS+ or CM Services. 
Take the following into consideration: 

1. Use CMS without CTS+ integration in the following situations: 

• If you already know NWDI with CMS and you are fine with the process and features 
offered and CTS+ integration is not (yet) needed. 

• If you are new to NWDI, and you do not know neither CMS nor CM Services, and CTS+ 
integration is not (yet) needed 

• If transporting on SCA granularity is sufficient 

2. Use CMS with CTS+ integration only in the following situations: 

• If you want to use CTS+ as the transport tool for the following reasons: 

i. CTS+ allows more flexible transport landscapes compared to CMS 

ii. Java transports need to be coupled with other transports 

iii. Integration in SAP's Change Control Process tools is required 

• If transporting on SCA granularity is sufficient 

3. Use CM Services (always with CTS+) only if transporting on SCA granularity is not sufficient and 
you would like to perform transports on more granular level (SDA/DC) by using deployable 
transport. 

 

http://service.sap.com/sap/support/notes/1361909
http://service.sap.com/sap/support/notes/1775838
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There are some restrictions for the usage of CM Services in SAP NetWeaver 7.3 that you should take into 
consideration:  

■ CM Services require a NWDS which supports releasing the activities in the transport view. For 

versions of the developer studio which support releasing activities, refer to SAP Note 1361909. If 

you develop Web Dynpro Java, Business Process Management, Business Rules Management, 

Composite Application Framework or Visual Composer, the runtime system and the developer 

studio have to be on the same release (version / SP). If you would like to use CM Services for a 

runtime system which is not on a release which supports CM Services, you have to use an 

additional NWDS for releasing the activities. 

■ A non-ABAP system is represented by a three letter acronym in CTS (the SID). The name of the 

development configuration created in SLD via CM Services is the same three letter acronym. You 

cannot change this name. 

■ Solution for maintenance tracks described on SCN (Best Practices for NWDI: Track design for 

ongoing development) is not supported for CM Services. You can find the guide Landscape 

Setup for Ongoing Java Development with CM Services in CTS+ here on SCN which describes 

how to handle this topic with CM Services. 

■ Mixed scenarios where sources (Activities) are transported only from a DEV to TST and after 

that, only complete SCA files are transported to the PRD System are not supported. 

 

We recommend the following: 

■ If you would like to use the transport of deployables, you should use the Deploy Web Service on 

both the NWDI and the CTS system as shown in the following figure. 

 
This configuration requires a little bit of additional effort when configuring the scenario, but later 

on when you use the scenario, there is one system less that has to be up and running during 

deployments: the Deploy Web Service on the NWDI (let’s call it CTSDEPLOY_DI) is only needed 

during the development phase (and for importing the required archives and sources from your 

upload system into your development system if you do not use the Synchronize Service). If an 

import into TST or PRD is triggered from the TMS of your CTS system, the Deploy Web Service 

on the CTS system (let’s call it CTSDEPLOY) will be used. The NWDI system is not needed or 

contacted during this step. 

http://service.sap.com/sap/support/notes/1361909
http://scn.sap.com/people/marion.schlotte/blog/2006/03/30/best-practices-for-nwdi-track-design-for-ongoing-development
http://scn.sap.com/people/marion.schlotte/blog/2006/03/30/best-practices-for-nwdi-track-design-for-ongoing-development
http://scn.sap.com/docs/DOC-31315
http://scn.sap.com/docs/DOC-31315
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■ If you would like to use the transport of sources, you have to use the CM Services and the Deploy 

Web Service on one system. We recommend that you use the NWDI for this purpose 

 

 CAUTION 

The figure above might give the impression that you don’t need an AS Java on your CTS 
system. For setting up CM Services for source transports as described in this guide, this is 
true. But if you are using or plan to use the transport of deployables or to use the CTS 
system for transporting e.g. Portal objects as well, you will need the Deploy WS on the CTS 
System. For transporting Portal objects, the recommendation is to use the Deploy Web 
Service on the CTS system. 

 

■ You can use any SAP NetWeaver System on SAP NetWeaver 7.31 SP 2 or up or SAP Solution 

Manager as CTS system. For the full functionality including the option to use CTS e.g. for SAP 

HANA or your own applications, the new Transport Organizer Web UI and Import Queue Web UI, 

you should have CTS_PLUG installed on the CTS system (CTS_PLUG is automatically part of 

SAP Solution Manager starting with SAP Solution Manager 7.1 SP5). For details on CTS_PLUG, 

refer to the SAP Library at 

http://help.sap.com/saphelp_ctsplug20sm71/helpdata/en/eb/0e1c7be26249e0911c5d688d3bfa06

/frameset.htm  

 CAUTION 

Keep in mind that the CTS system has to be on enhancement package 2 for SAP 
NetWeaver 7.0 for the full functionality of object lists as a basis release and on 
enhancement package 1 SP7 for SAP NetWeaver 7.0 to be able to use the scenario at all. If 
you are using SAP Solution Manager for CTS, make sure that your SAP Solution Manager 
is using this basis release at least. The SP naming of SAP Solution Manager is different 
from the SAP NetWeaver Support Package level it is based on. 

■ Use the transport of deployables (either SCA or activity-based SDA transport – not direct SDA 

export from Export Service UI) whenever possible. 

■ It is not recommended to use the Activity transport (deployables or sources) if you are modifying 

ESS or MSS sources delivered by SAP. 

■ If you decide to use the Activity transport, use it in combination with the SCA transport. E.g. if you 

did a lot of changes to very different development components, you should transport the 

complete SCA instead of a lot of source files. 

■ Sources should only be changed in the DEV system. For the transport of sources scenario it is 

technically possible to access (via the respective development configuration) and to change the 

sources for your target systems. This is absolutely not recommended. Set DTR ACLs accordingly 

for the DTR workspaces of all your target systems in your transport route. 

http://help.sap.com/saphelp_ctsplug20sm71/helpdata/en/eb/0e1c7be26249e0911c5d688d3bfa06/frameset.htm
http://help.sap.com/saphelp_ctsplug20sm71/helpdata/en/eb/0e1c7be26249e0911c5d688d3bfa06/frameset.htm
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■ If you already configured your NWDI and if you are using tracks in CMS for your development 

process, you can continue to do so. CM Services and CMS can’t be used together e.g. in one 

transport route or track, but you could use CMS for one development project and the CM 

Services for another one. Both of them could use the same DTR and CBS. You only need 

separate development configurations and Landscapes (for CM Services configured in TMS, for 

CMS set up as a track in CMS or as a transport landscape in TMS). 

6 Initial Setup and Configuration of CM 
Services 

In this chapter, we assume that you start from zero – this means that neither CTS nor NWDI or SLD are 
configured up to now. Concerning NWDI only the Design Time Repository (DTR) and the Component 
Build Service (CBS) are needed in case you use the development and transport options offered by CM 
Services. Therefore the configuration of the Change Management Service (CMS) is not part of this guide. 
If you already configured your SLD, CTS system, or NWDI, take a look at the appropriate sections in this 
guide anyhow to find out whether your configuration fits with the one needed for CM Services. 

Note 

For the initial setup of CM Services in SAP NetWeaver 7.30, a CTC template is available 
that assists you in performing all configuration steps. This is a big difference to the initial 
setup and configuration procedure that was necessary in enhancement package1 and 2 for 
SAP NetWeaver 7.0 and on SAP NetWeaver Composition Environment 7.2 

This chapter concentrates on the initial setup and enablement of CM Services and NWDI (including SLD). 
For the configuration of your system landscape see chapter System Landscape Configuration and the 
usage of development configurations is described in chapter Development and Export Process. 

 

6.1 Assumptions 

We assume that you are working with two dialog users: one who is a developer (nwdi_dev) and one who 
is an administrator (nwdi_adm). In addition, technical users are needed to establish connections etc. The 
dialog users are just examples. You can use other users / user IDs for sure. Make sure that the same 
user IDs (and in some cases passwords) are used in SLD, NWDI, CM Services and on the CTS system 
(ABAP) or that you have Single Sign-On in place. 

Note 

ABAP supports user IDs with a length up to 12 characters. So you should only use user-IDs 
with up to 12 characters in all systems. 

 

This guide assumes that you are using the CM Services and the SLD on your NWDI system. This would 
mean that you use an NWDI on SAP NetWeaver 7.30 or higher. If you are not able to do so, please check 
the chapter Configure Users on CM Services server. Note that you would also have to make sure that the 
required users exist on all servers (SLD, Name Server, CBS, and DTR). 

In addition, we assume that you are already using Web Dynpro ABAP on your CTS system. If this is not 
the case, take a look on the SAP Library to learn how to activate Web Dynpro ABAP for a certain system: 
http://help.sap.com/saphelp_nw73/helpdata/en/43/e86de5008b4d9ae10000000a155369/frameset.htm 

For the transport request handling you will use the Web Dynpro ABAP application Transport Organizer 
Web UI that has to be enabled by activating the service CTS_ORGANIZER (CTS_BROWSER if you are 
using a CTS system on SAP NetWeaver without CTS_PLUG or SAP Solution Manager 7.01). This is 
done via transaction SICF. For more details please have a look at SAP Library. 

http://help.sap.com/saphelp_nw73/helpdata/en/e5/998566c2174196a12b72e7c7af51e7/frameset.htm 

http://help.sap.com/saphelp_nw73/helpdata/en/43/e86de5008b4d9ae10000000a155369/frameset.htm
http://help.sap.com/saphelp_nw73/helpdata/en/e5/998566c2174196a12b72e7c7af51e7/frameset.htm
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Note 

If CTS_PLUG is installed on your CTS system (SAP NetWeaver 7.3 including enhancement 
package 1 SP1 and later or SAP Solution Manager 7.1), there is a new version of the 
Transport Organizer Web UI available (CTS_ORGANIZER in SICF) Refer to the SAP 
Library for details: 
http://help.sap.com/saphelp_ctsplug20sm71/helpdata/en/ac/56514c0553494fb856884ce514
3dd6/frameset.htm  

 

6.2 Configuring SLD 

1. If you are using the SLD for the first time, you can simplify the initial configuration by executing the 

appropriate configuration task in the Configuration Wizard. 

Note 

For more information on the configuration wizard. Refer to the SAP Library at 
http://help.sap.com/saphelp_nw73/helpdata/en/54/a1f02a8178468d89553a4844edf0be/fram
eset.htm 

2. On your SLD system, in the SAP NetWeaver Administrator (http://<host>:<port>/nwa), choose 

Configuration → Scenarios  → Configuration Wizard. 

 

3. Choose Functional Unit Configuration UI. 

 

http://help.sap.com/saphelp_ctsplug20sm71/helpdata/en/ac/56514c0553494fb856884ce5143dd6/frameset.htm
http://help.sap.com/saphelp_ctsplug20sm71/helpdata/en/ac/56514c0553494fb856884ce5143dd6/frameset.htm
file:///C:/Users/D033035/Desktop/For%20more%20information%20on%20the%20configuration%20wizard.%20Refer%20to%20the%20SAP%20Library%20at%20http:/help.sap.com/saphelp_nw73/helpdata/en/54/a1f02a8178468d89553a4844edf0be/frameset.htm
file:///C:/Users/D033035/Desktop/For%20more%20information%20on%20the%20configuration%20wizard.%20Refer%20to%20the%20SAP%20Library%20at%20http:/help.sap.com/saphelp_nw73/helpdata/en/54/a1f02a8178468d89553a4844edf0be/frameset.htm
file:///C:/Users/D033035/Desktop/For%20more%20information%20on%20the%20configuration%20wizard.%20Refer%20to%20the%20SAP%20Library%20at%20http:/help.sap.com/saphelp_nw73/helpdata/en/54/a1f02a8178468d89553a4844edf0be/frameset.htm
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4. Select System Landscape Directory and choose Enable automatically.  

 
The wizard will guide you through a few steps: 

1. When prompted for passwords, enter the J2EE Administrator password, and define and confirm a 
Master Password according to your policy. To continue executing the templates, choose Next. 

 

 CAUTION 

Remember the master password – you will need it later on. 

2. In the next step, choose Set up a new local SLD (the guide describes a set-up from zero) Choose 
This SLD will be used as a name server for development as well and click Next. 
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3. After the Configuration Wizard has completed the configuration of the System Landscape Directory, 
choose Return to Task List. 

 

6.3 Configuring NWDI with CM Services 

If you are using the NWDI for the first time, use the appropriate task in the Configuration Wizard to 
configure NWDI together with CM Services. 

1. Select NWDI using CM Services - recommended and click on Enable automatically. We 
recommend that you use this option for configuring the NWDI because it automatically selects the 
‘Java Foundation’ as well. 
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2. When prompted for passwords, enter the Administrator Password, and the Master Password that 
you have used before. To continue executing the templates, choose Next. 

 

3. In the next step, the users NWDI_ADM, NWDI_DEV and NWDI_CMSADM are created. Enter a 
Master Password for these users 

 

 CAUTION 

Remember the master password – you will need it later on. 

4. After the Configuration Wizard has completed the configuration of the NWDI using CM Services, 
you can exit the Configuration Wizard 
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6.4 Mapping Roles in UME  

Now, you should check whether the actions and roles introduced by CM Services are assigned to the 
appropriate users. On your NWDI server, open the user administration and search for the group 
NWDI.Administrators. Make sure that the role SAP_DI_ADMINISTRATOR is assigned to this group. 

Check also that the role SAP_DI_DEVELOPER is assigned to the group NWDI.Developers. 

To do so, you can e.g. search for all groups which do contain DI in their name. Mark then the role that you 
like to check and click on Go in the section Details on the tab Assigned Roles... 

 

If the roles are not assigned correctly, do the following: 
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Open the UME of your NWDI System. Use the URL http://<server>:<port>/useradmin. Search 

for the group NWDI.Administrators and select it. Go to the tab Assigned Roles, choose Modify. 

 

Search for the role SAP_DI_ADMINISTRATOR and Add it to the group. 

 

Save your changes. 

Repeat the previous steps to add the role SAP_DI_DEVELOPER to the group NWDI.Developers. 

 

6.5 Required Connections 

As a next step, you have to connect your NWDI system – where the CM Services run - and your CTS 
system. This is done via three connections. 

• One connection points from the CTS system to the NWDI system. It is needed to call the Deploy 
Web Service and the DI Config Services. These services run on the NWDI. They are needed to 
create development configurations and if you would like to import a request into a system for 
which a development configuration has been created. 
The configuration for this connection is done on the CTS system in the transactions LPCONFIG 

and SM59. For this destination, you have to create a user on the NWDI which is then entered as 

connecting user in SM59 (e.g. CTS_RFC). 

• The second connection points from the NWDI to the CTS system, which means from Java to 
ABAP. This connection is created as an RFC destination (JCo Connection) on the NWDI server 
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and is required to be able to retrieve e.g. a transport request from CTS when exporting an activity 
via NWDS or using the DI Export Service UI. For this connection, the user(s) developing with 
NWDI (e.g. NWDI_DEV) have to be created on your CTS system. 

Note 

Each user who does changes to Java sources and would like to attach these changes to a 
transport request has to exist with the same ID both on the CTS system and on NWDI. 

 

• The third connection points from the AS ABAP of your CTS system to the AS Java of your CTS 
system. It is used when deployables are imported e.g. into your test or productive system. It is not 
mandatory. Nevertheless, we recommend configuring this connection as well – it reduces the 
number of systems that have to be available when importing a transport request which contains 
deployables. This destination cannot be used when importing sources. In addition, this 
destination might already be configured in your system if you are already using CTS for other use 
cases like SAP NetWeaver Enterprise Portal or if you are using CTS in connection with CMS. 

 

The following sections describe in detail how to configure CM Services server and the CTS system. The 
configuration of the different connections is part of this configuration. We will first do all the configuration 
parts that are required on the CM Services server and then all the configurations on the CTS Server. 

6.6 Configuring the CM Services Server 

This chapter explains the basic steps for configuring the connection between the CM Services and the 
CTS system in short. For more information about the configuration, see the SAP Library at:  

http://help.sap.com/saphelp_nw73/helpdata/en/2b/326d6274134cea8b217f24889d19c1/frameset.htm. 

6.6.1 Creating a User for RFC Destinations from CTS System 
to CM Services 

1. This section describes how to create a user on the CM Services server that is needed for 
communication between the CTS system and the CM Services. We will name this user CTS_RFC. 
But this is for sure only an example. 

1. Go to the user administration of your NWDI server (Error! Hyperlink reference not valid.) 

http://help.sap.com/saphelp_nw73/helpdata/en/2b/326d6274134cea8b217f24889d19c1/frameset.htm
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2. Choose Create User 

 

3. On the following screen, enter a Logon ID, a real password (you won’t have to change it later on) 
and the Last Name at least. Choose Technical User as Security Policy. Click Save. 

 
4. On the Assigned Roles tab page, search for the roles SAP_CTS_DEPLOY and 

SAP_CTS_DI_CONFIGURATOR and assign them to the user CTS_RFC. 

 

Note 

If your company policy says that you should only assign roles to groups, you can also do so 
in here. Create the user, create a group with the roles above and assign the user to the 
group. For more information refer to the SAP Library at 

http://help.sap.com/saphelp_nw73/helpdata/en/4a/e06f429c789041e10000000a1550b0/fra
meset.htm 

 

http://help.sap.com/saphelp_nw73/helpdata/en/4a/e06f429c789041e10000000a1550b0/frameset.htm
http://help.sap.com/saphelp_nw73/helpdata/en/4a/e06f429c789041e10000000a1550b0/frameset.htm
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6.6.2 Creating an RFC Destination from CM Services to CTS 

Now, we will create the destination which is needed on the CM Services server (the NWDI) to be able to 
retrieve transport requests from CTS etc. 

1. In the SAP NetWeaver Administrator of your CM Services system, choose Configuration → 
Destinations. 

 
2. Choose Create... 

 
3. Choose Local Java System <SID> as Hosting System. Enter 

sap.com/com.sap.tc.di.CTSserver in the Destination Name field and choose Destination 

Type RFC. Click Next. 

 
4. Enter the required data as shown in the following figure and click Next: 

a. Decide whether you use Load Balancing for your CTS system (in our example, we don’t 

do so). 

b. Target Host: server name of the CTS system 

c. System Number: system number of the CTS system 

d. System ID: SID of the CTS system 
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Click Next 

 

Note 

We recommend that you use SNC whenever possible. 

5. Enter the Logon Data: In the Authentication section, select Current User (Assertion 

Ticket) as Authentication for the connection to the CTS communication system.  

Client: Client in which the Transport Organizer Web UI is running (same value as used when 
creating the non-ABAP system on the CTS system for parameter NON_ABAP_WBO_CLIENT) 
Choose Finish to complete the Destination Wizard 
The permissions required for each user who should be able to use this connection are described 
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in the chapter Creating a Developer User. 

 

Note 

We recommend that you use SSO. If you cannot use SSO or want to use a dedicated 
service user, select the option Configured User and enter your preferred language, a 

client, and an appropriate service user and password. This configuration is not 
recommended. We recommend that you configure SSO between your NWDI and the CTS 
system. Details are available in the SAP Library at http://help.sap.com/nwsso and for details 
on issuing and accepting tickets, see here: 
http://help.sap.com/saphelp_nw73/helpdata/en/4d/a5ddc832211dcde10000000a42189c/con
ent.htm?frameset=/en/4a/412251343f2ab1e10000000a42189c/frameset.htm. 

6. Choose Ping Destination to test your destination. Make sure that you receive the message Test is 
successful on top of the screen. 

 

6.7 Configuring the CTS System 

This guide assumes that the system that you would like to use as CTS system is configured as domain 
controller. The following steps explain the additional configuration steps to set up CM Services. 

All configuration tasks on the CTS system have to be done in the client that is later used to execute the 
transports unless otherwise mentioned. 

6.7.1 Creating a Developer User 

Due to the decision in Creating an RFC Destination from CM Services to CTS to use the option Current 
User (Assertion Ticket ) the user who is logged on to the system where the CM Services run, needs 
special permission on the CTS system as well. Make sure that the user has been assigned the correct 
role on the CTS system. We assume that the user who is developing (and is therefore also logged on to 

http://help.sap.com/nwsso
http://help.sap.com/saphelp_nw73/helpdata/en/4d/a5ddc832211dcde10000000a42189c/conent.htm?frameset=/en/4a/412251343f2ab1e10000000a42189c/frameset.htm
http://help.sap.com/saphelp_nw73/helpdata/en/4d/a5ddc832211dcde10000000a42189c/conent.htm?frameset=/en/4a/412251343f2ab1e10000000a42189c/frameset.htm
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the CM Services system since the NWDI runs on this system) does not yet exist on the CTS system. So 
we will now create the user and assign the required permissions. 

1. Log on to your CTS system and open transaction SU01. 

2. Enter NWDI_DEV as User and click on create. 

 
3. Enter the required data on the Address tab 

 
4. Switch to the Logon Data tab. Enter a New Password and the same password for Repeat 

Password. 
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5. Switch to the Roles tab and assign the role SAP_CTS_PLUS. Save the user. 

 

Note 

In older releases the role SAP_CTS_PLUS may not be complete. If you run into permission 
issues when working with the user, check that the role is complete. Details are available in 
the chapter Checking Role SAP_CTS_PLUS 

6. Repeat the previous steps for every user who is developing in Java and has to attach changes to 
a transport request (be it from within the developer studio or the export service). The users are 
required on the CTS system e.g. to get a transport request when exporting. You can use the user 
IDs of your developers. Make sure that you use IDs which allow to be used in SSO mode. 
Remember that ABAP supports user IDs with a length of up to 12 characters. NWDI_DEV is used 
as an example in this guide. 

Note 

If the users already exist on the CTS system, make sure that they have sufficient 
permissions – assign the role SAP_CTS_PLUS to them. 

 

7. Log on to your CTS system with the user NWDI_DEV in order to change the initial password. 

6.7.2 Configuring RFC Destination and Logical Ports 

Have a look at the figure below. It illustrates how logical ports and destinations are connected. The logical 
ports (CTSCONFIG and CTSDEPLOY_DI) use the same RFC destination (CTSCONFIG). Furthermore 
the user CTS_RFC which was created on the CM Services server (see chapter Creating User for RFC 
Destinations from CTS System to CM Services) is used for the RFC connection from CTS to the CM 
Services system. 
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Note 

The Deploy Web Service (CTSDEPLOY) e.g. for your portal transports can be hosted on a 
different server. For the portal, the Deploy Web Service usually runs on the AS Java of your 
SAP Solution Manager. For CM Services the CTS Deploy Web Service on the CM Services 
server has to be used in case you use the source transports and for the development 
system for the transport of sources and deployables (see Introduction, systems, where 
parameter DI_System is set to TRUE (needs to be in upper case)). For the test and 
productive systems, you need the RFC connection CTSDEPLOY as well. In this case, the 
RFC connection CTSDEPLOY that might already be in use for transporting portal content 
can be used as well. If you are not using CTS for any other use case on your SAP Solution 
Manager up to now, take a look at step 5 of this chapter to learn how to configure 
CTSDEPLOY. 

 

6.7.2.1 Configure RFC Destinations 

An RFC destination is needed for the communication between the CTS system and the CM Services 
system: CTSCONFIG. The required user CTS_RFC for this RFC connection with special permission on the 

CM Services system has already been created in step Creating User for RFC Destinations from CTS 
System to CM Services. 

Proceed as follows to create the RFC destination: 

1. Log on to the client of your CTS system that you are using for transports (=where the Transport 
Organizer Web UI runs). Open transaction SM59 and open the HTTP Connections to External 
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Server section. Check whether the connection CTSCONFIG is already available. 

 
2. Click on Create if CTSCONFIG does not yet exist.  

 
If the connection already exists, take a look at the following steps as well to make sure that the 
configuration is done as needed for this setup. If this is not the case, then you have to create an 
additional destination with a different name and use this destination for the configuration of the 
CM Services 

3. Enter CTSCONFIG as RFC Destination, a Description, the Target Host (your NWDI/CM Services 

server), and as Service No the port of your server where the CM Services and the Deploy Web 
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Service run. Make sure that the Connection Type is G. 

 
4. Go to the Logon & Security tab. Click on Continue to confirm that you know that http connections 

can be insecure 

 

Select Basic Authentication and enter the user and the password that you have specified in 
Creating User for RFC Destinations from CTS System to CM Services (CTS_RFC in our 

example). 
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Note 

We recommend that you use SSL whenever possible. 

5. Go to the Special Options tab page and select No Timeout. 
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6. Choose Connection Test. 

 

Note 

The connection test only tests the connection to the server without using the specified user 
and password. 

7. Make sure that your destination works. 

 

8. To transport deployables you have to configure an RFC destination pointing from the AS ABAP of 
your CTS system to the AS Java of your CTS system as well. This destination should be called 
CTSDEPLOY. Check whether the destination already exists. 

 

Note 

This destination is also needed if you transport e.g. portal content via CTS+. If you already 
do so (and use the same CTS system for this purpose) the destination should already exist. 

9. If the destination does not exist, create it. Enter CTSDEPLOY as RFC Destination, a Description, 

the Target Host (AS Java of your CTS system), and as Service No the port of the AS Java that is 
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used for the CTS system. Make sure that the Connection Type is G. 

 
10. Go to the Logon & Security tab. Click on Continue to confirm that you know that http connections 

can be insecure. 
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11. Select Basic Authentication and enter a user and the password. The user should have the role 
SAP_CTS_DEPLOY assigned on the AS Java. 

 

Note 

If your system is configured accordingly, use SSL (select Active for SSL in the section 
Security Options). If SSL is not yet configured we recommend that you do so. 

12. Go to the Special Options tab page and select No Timeout. 

 
13. Test your connection. 
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6.7.2.2 Configure Logical Ports 

Two logical ports are needed for the communication between the CTS system and the CM Services 
system: CTSCONFIG and CTSDEPLOY_DI. One logical port is required for the communication between 
the AS Java and the AS ABAP of your CTS system: CTSDEPLOY. 

CTSDEPLOY_DI is needed to reach the Deploy Web Service on the NWDI system to manage the import 
of sources (import into NWDI and following automatic deployment to the development runtime system). 
The Deploy Web Service on the AS Java of your CTS system cannot be used in this case. 
One Logical Port CTSDEPLOY is needed for the communication between the AS ABAP and the AS Java 
of your CTS system. This port is needed if you want to use the transport of deployables. If you decide to 
use the transport of sources, this port is not needed. Nevertheless, SAP delivers this port by SAP by 
default and you should not delete it as you might need it for other transports on your SAP Solution 
Manager - e.g. portal content. 

If you use deployable transport, you do not need the port CTSDEPLOY_DI. It is only needed if you plan to 
execute imports into your development system (e.g. because you manually add a transport request to the 
queue). 

Check whether they are available and active on your CTS system. If not create them as described in this 
chapter. The logical ports CTSDEPLOY and CTSCONFIG are delivered by SAP and should be available 
on your system. Only for some older releases it is possible that they are not available. 

At first, we are going to check whether the logical port CTSCONFIG is available 

1. Log on to your CTS system in client 000 and call transaction LPCONFIG. Confirm the pop-up 

message that the transaction is obsolete. Click Continue. For this purpose, you have to use 
transaction LPCONFIG. 

 
2. Enter CO_TDIDICONFIGURATION_SERVICE as Proxy Class and CTSCONFIG as Logical Port. 

Make sure that the option Default Port is not set. 
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3. Click on Display. Check that the logical port exists, that it is active and that the parameters are 
set as shown in the following figure. 

 
4. The logical port CTSDEPLOY should be configured with the values shown in the following figure. 

It should be the Default Port and it has to be active. 

 

To create the logical port CTSDEPLOY_DI, if one of the ports does not exist, or if the parameters are not 
set correctly, proceed as follows: 

1. Set the system change option of the client 000 to Modifiable. For more details on that see 
http://help.sap.com/saphelp_nw73/helpdata/en/2b/326d6274134cea8b217f24889d19c1/frameset.
htm 

http://help.sap.com/saphelp_nw73/helpdata/en/2b/326d6274134cea8b217f24889d19c1/frameset.htm
http://help.sap.com/saphelp_nw73/helpdata/en/2b/326d6274134cea8b217f24889d19c1/frameset.htm
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2. Enter the Proxy Class CO_TFLDEPLOY_PROXY_VI_DOCUMENT and the Logical Port 

CTSDEPLOY_DI. Click on Create. 

 
3. Enter a Description. Enter CTSCONFIG as HTTP Destination and 

/DeployProxy/default?style=document as Path Suffix 

 

Note 

It is correct and it is the intended setup that this logical port also uses the http destination 
CTSCONFIG since it also requires a connection to the CM Services system. 

4. Save your logical port. You will be asked for a transport request. You can either create a new one 
or use an existing one. 
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Note 

In most cases, this change is not going to be transported. So choose a transport request 
which does not contain any objects that require a transport to another system. 

5. Activate the logical port. 

 

6.7.3 Activate Services in SICF 

Several Web Dynpro ABAP applications are needed to be able to use CTS. Make sure that they are 
activated, or activate them if they are not active. To do so, open transaction SICF in the client where you 

also configure your system landscapes in TMS, and search for services where the name starts with CTS. 

 

For more details refer to the SAP Library at  

http://help.sap.com/saphelp_nw73/helpdata/en/e5/998566c2174196a12b72e7c7af51e7/frameset.htm 

 

6.7.3.1 Transport Organizer Web UI 

The Transport Organizer Web UI is needed to manage the transport requests for non-ABAP systems. 
You can create transport requests, assign files, release requests etc. To be able to use the Web Dynpro 
ABAP application Transport Organizer Web UI you need to make sure that - depending on the release of 
your CTS system - the service CTS_BROWSER or CTS_ORGANIZER is active. For more details on the 
Transport Organizer Web UI, refer to the SAP Library at 
http://help.sap.com/saphelp_nw73/helpdata/en/b5/6d03660d3745938cd46d6f5f9cef2e/content.htm  

Note 

If CTS_PLUG is installed on your CTS system (SAP NetWeaver 7.31SP1 and later or SAP 
Solution Manager 7.1), CTS_ORGANIZER will automatically be used whenever you click a 
link provided inside applications to manage transport requests. There is no configuration 
option for one or the other version of the Transport Organizer Web UI. So activate the 
service that fits to your system. 
With CTS_PLUG, there is also the Import Queue Web UI available. You can use it to 
manage imports for your system via a Web UI. More information on the Import Queue Web 
UI is available in the SAP Library at 

http://help.sap.com/saphelp_nw73/helpdata/en/e5/998566c2174196a12b72e7c7af51e7/frameset.htm
http://help.sap.com/saphelp_nw73/helpdata/en/b5/6d03660d3745938cd46d6f5f9cef2e/content.htm
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http://help.sap.com/saphelp_ctsplug20sm71/helpdata/en/4b/b9a1222f504ef2aa523caf6d22d
1c9/content.htm  
More information on the CTS Plug-in, features and installation prerequisites is also available 
in the SAP Library at 
http://help.sap.com/saphelp_ctsplug20sm71/helpdata/en/eb/0e1c7be26249e0911c5d688d3
bfa06/content.htm?frameset=/en/4b/b9a1222f504ef2aa523caf6d22d1c9/frameset.htm  

 

6.7.3.2 Object List Browser 

To be able to use the Object List Browser to see the content of an attached dip (Development 
Infrastructure Package) file you need to activate the Web service CTS_OBJECTLIST_BROWSER.  

 

 

7 System Landscape Configuration 
Assuming that your CTS system and NWDI with CM Services are enabled, the following chapter 
describes how to set up your transport and development configuration landscape. 

 Example 

In this guide, we will use three runtime systems as a sample landscape. We will have a 
development system (DEV), a test system (TST) and a production system (PRD). So we 
need to setup a non-ABAP DEV, TST and PRD system in TMS of your CTS system. For 
each system, you have to decide if a development configuration is needed and if the system 
is a source and/or target system. In addition the transport routes have to be created 
accordingly. 

When creating a development configuration for a system, DTR workspaces and CBS buildspace are 
created automatically. But initially they are empty! Therefore you have to fill these buildspaces (and 
workspaces) with the required libraries (compared to the CMS Check-In and import to development). In 
CM Services this is done with the help of the Synchronize Service. 

In our example, we will use the deployable transport. For this scenario, the following configurations are 
required: 

Systems 

DEV:   non-ABAP source and target system with development configuration 

TST:   non-ABAP target system  

PRD:   non-ABAP target system  

 

Transport Routes:  

DEV   → TST:  Consolidation Route 

TST   → PRD:  Delivery Route 

 

If you plan to transport sources, the following configuration is required: 

Systems:  

DEV:   non-ABAP source and target system with development configuration 

TST:   non-ABAP target system with development configuration 

PRD:   non-ABAP target system with development configuration 

 

Transport Routes:  

DEV   → TST:  Consolidation Route 

TST   → PRD:  Delivery Route 

http://help.sap.com/saphelp_ctsplug20sm71/helpdata/en/4b/b9a1222f504ef2aa523caf6d22d1c9/content.htm
http://help.sap.com/saphelp_ctsplug20sm71/helpdata/en/4b/b9a1222f504ef2aa523caf6d22d1c9/content.htm
http://help.sap.com/saphelp_ctsplug20sm71/helpdata/en/eb/0e1c7be26249e0911c5d688d3bfa06/content.htm?frameset=/en/4b/b9a1222f504ef2aa523caf6d22d1c9/frameset.htm
http://help.sap.com/saphelp_ctsplug20sm71/helpdata/en/eb/0e1c7be26249e0911c5d688d3bfa06/content.htm?frameset=/en/4b/b9a1222f504ef2aa523caf6d22d1c9/frameset.htm
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 CAUTION 

The following scenario is not recommended: Configure the TST system as source system to 
be able to create a transport request, export and attach an SCA file (compared to the CONS 
System in a CMS track) and then transport it to the PROD system. 

 

Independent of the transport scenario (source or deployable transport) the following configuration parts 
have to be done in any case: 

1. Create a non-ABAP DEV system with development configuration (source system) 

2. Use the Synchronize Service to provide the required libraries to the DEV system / the respective 

workspaces and buildspace 

So we are now starting with executing these two steps. 

7.1 Creating a Non-ABAP System with Development 
Configuration 

This chapter describes how to configure the development system (DEV), which is a source (to be able to 
create a transport request and attach .dip or .sca files) and target system (for the deployment during the 
activation process triggered in NWDS) with a development configuration. This is true for all use cases 
using CM Services. 

 CAUTION 

Do not create a non-ABAP system for your NWDI. The transport route consists of the 
runtime systems. 

 

1. On your CTS system (domain controller), call transaction STMS and click on System Overview. 
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2. Choose SAP System → Create → Non-ABAP-System 

 
3. Enter the SID in the field System. In our example, we enter DEV. Enter a Description as well. 

Enter your CTS system as Communication System: (the system where you configured the logical 
ports and the RFC Destinations – CTSCONFIG etc). 

Select Create Development Configuration. 

 
4. If this is the first system with a development configuration that you create, now, a pop-up will be 

shown where you have to enter the SLD URL. Enter the URL to the SLD that you have 
configured during the NWDI setup (see chapter Configuring NWDI with CM Services). Click on 
Continue. 

 

 Recommendation 

Use https whenever possible. 

5. Choose Activate Transport Organizer and make sure that the correct client is set. 
Choose Activate Deployment Service and choose SDM or DC (depending on the release of your 
runtime system).  
Enter the Target Host and the System No of your development runtime system. 
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Click Save. 

 

Note 

For all runtime systems which are on SAP NetWeaver 7.1 or later, use DC (=Deploy 
Controller) as Method. For lower releases SDM is used for deployments. 

Note 

This configuration is different from what you might know when using CTS, for example, for 
the portal. The development system has to have both configurations, source and target 
system. The target system is needed to deploy your applications to this runtime during the 
activation step using NWDS/NWDI containing e.g. the required libraries. 

6. For deployments to the runtime system, a user with appropriate permissions is needed. In the 
dialog box <SID>: Set User and Password for Deployment SDM/DC enter a user who has 
permissions to execute deployments on the development runtime system. 

 

Note 

For runtime systems with SDM (SAP NetWeaver AS Java 7.0 and enhancement packages) 
use SDM as a user and the SDM password. As of SAP NetWeaver AS Java 7.1 the Deploy 
Controller is used for deployments. In this case, enter a user with deploy permission and the 
appropriate password. 

7. If this is the first DI system that you create, you will now be asked to enter a user and password 
for the SLD. Enter the master password that you defined when setting up the NWDI (see chapter 
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Configuring NWDI with CM Services) and click Continue. 

 

Note 

If you set up your NWDI to be used with another (already existing) SLD, you have to enter a 
user and password for this SLD. 

Note 

You can use only one SLD per CTS system – therefore you are only asked for an SLD URL 
and a user / password when creating your first DI system. 

 

8. If this is the first DI system that you create, you are now required to enter a user and a password 
for the CM Services. Enter the master password that you defined when you set up the NWDI (see 
chapter Configuring NWDI with CM Services) and click Continue. 

 

 

Note 
If you do not use CM Services on the system where DTR / CBS run, you have to create the 
user that you like to use in here on the CM Services system as well. 

9. After you saved the DEV system in TMS, a browser window showing the Development 
Infrastructure. Development Configuration Management opens automatically. This UI runs on the 
CM Services server. If you do not have single sign-on in place, you have to log on at first. Use the 
user NWDI_ADM with the master password that you set when configuring the NWDI (see chapter 
Configuring NWDI with CM Services). We will continue with the configuration in this UI after 
adapting some parameters for the system DEV in TMS. 

7.1.1 Adapting TMS parameters 

1. Double-click on the system DEV in the System Overview. 
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2. Change the parameter DEPLOY_WEB_SERVICE to CTSDEPLOY_DI. 

 

Note 

This change is required for every system where the parameter DI_SYSTEM is set to TRUE 
(in upper case). 

Note 

If you are using a release below SAP NetWeaver 7.0 including enhancement package 2 on 
your CTS system and you were not able to choose between SDM and DC (only one option 
was available), you also have to change the port for DEPLOY_URL from 5xx18 to 5xx04 if 
your runtime system is on a release that uses the deploy controller for deployments. 

 
 

3. In addition you can define that the AS Java gets the files from the AS ABAP (the Transport 
directory) when executing an import: 

• You can use a mount directory or a shared directory – the parameter 
DEPLOY_DATA_SHARE which is used by default. 

• You can alternatively explicitly set a SAP Java Connector connection (JCo connection), 
with the parameter CTS_FILE_PROVIDER_URI. For the JCo connection you need to set 
the File Provider User and Password. In the TMS Configuration of your system choose 
Goto → File Provider User/Password. The users that are entered in the destinations 
CTSDEPLOY and CTSCONFIG in SM59 have to have the permission 
Destination_Service_Write_Permission on the CM Services system in addition to the role 
SAP_CTS_DEPLOY. We recommend that you create a separate role containing this 
action and assign this role to the user that is used when the CTS system connects to the 
CM Services system. For more information, refer to SAP Note 1492665 and in the SAP 
Library at 
http://help.sap.com/saphelp_nw73/helpdata/en/81/5bb741b48d4c6ea8c94b534144ba3a/
content.htm. 

http://service.sap.com/sap/support/notes/1492665
http://help.sap.com/saphelp_nw73/helpdata/en/81/5bb741b48d4c6ea8c94b534144ba3a/content.htm
http://help.sap.com/saphelp_nw73/helpdata/en/81/5bb741b48d4c6ea8c94b534144ba3a/content.htm
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Note 

You have to delete the DEPLOY_DATA_SHARE parameter to be able to use the 

CTS_FILE_PROVIDER_URI parameter. Otherwise the system tries to access the Deploy 

Data share. 

Note 

For details on the CTS_FILE_PROVIDER_URI parameter, the possible values and 
permissions required refer to SAP Note 1492665. 

 

 

7.1.2 Configuring the Development Configuration 

Now you can start configuring the development configuration. You do this in the Development 
Configuration UI that opened in the browser when saving the non-ABAP system. 

1. What you can see on the System Landscape Directory tab should be ok since the information 
was passed on from the CTS system. Go to the Local Settings tab. 

 

http://service.sap.com/sap/support/notes/1492665


  

How To... Configure CM Services in SAP NetWeaver 7.3   

System Landscape Configuration  © 2025 SAP AG or an SAP affiliate company. All rights reserved. 51 

2. Click on Edit to change the development configuration. 

 
3. Set the options Repository Location and Build Tool Location. This will automatically add the 

respective paths. 
Define the Transport Settings. In our example, we are going to use the Deployable Export with 
the options to transport Software Components and Activities. More details can be found in the 
chapter Landscape Options. 
Make sure that the Export Destination shown in here is the one that you created in step Creating 
an RFC Destination from CM Services to CTS. 

 

Note 

If you have to connect one NWDI to more than one CTS system, you can also define more 
than one destination. We recommend that you add the SID of the CTS system to the name 
so that you know what the different destinations are made for (e.g. 
sap.com/com.sap.tc.di.CTSserver_CTS). Refer to the chapter Creating an RFC Destination 
from CM Services to CTS for creating a destination. 

Note 

Execute the next step “Software Component Definition” before saving these settings. The 
DTR and CBS URLs will be deleted if no software components are added for the 
development configuration. 

4. Click on the Software Component Definition. You can now add the SCs that you would like to 
develop in this development configuration. To do so, click on Add SC. All available software 
components are read from SLD and are provided in a list. Retrieving the list from SLD for the first 
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time might take a while – be patient. 

 
5. On the dialog box, you can choose from the existing SCs or create a new one. Refer to the 

chapter Creating a new SC for details if you would like to create a new SC. Filter the list 
according to the SCs you want to add to the development configuration, select them, and choose 
Add, and then Close. 

 
6. To view the dependencies of the SCVs, click on the triangle at the beginning of a row. 

 
7. Save your development configuration. 

 
8. Now the development system configuration is ready. But before you can start working with the 

development configuration as described in chapter Development and Export Process the required 
libraries need to be imported with the help of the Synchronize Service. The following chapter 
describes how to do this. 

Note 

If you closed the Development Configuration UI at some point during the configuration, you 
can always open it again from within TMS or NWA. 



  

How To... Configure CM Services in SAP NetWeaver 7.3   

System Landscape Configuration  © 2025 SAP AG or an SAP affiliate company. All rights reserved. 53 

Go to the details of your system in TMS and click on Development Configuration. 

 
In the SAP NetWeaver Administrator on your NWDI go to Configuration → Infrastructure → 
Development Infrastructure. 
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7.1.3 Get the required Software Component Archives 

To be able to develop an application for AS Java you need to import some basic libraries (required 
Software Component Archives) into CBS. You might also want to import SCs that you developed in the 
past into DTR. The Synchronize Service is used to manage these tasks. The Synchronize Service allows 
you to compare software component versions on the runtime system with what is imported into the NWDI 
If necessary you can adapt the development environment. It is no longer necessary to use an upload 
system and to create transport requests manually as you might have done in older CM Services versions. 

In our example, we will use the Synchronize Service to bring the SCAs required / to be developed to the 
system DEV (the respective workspace and buildspace on NWDI). As we will transport deployables, we 
only need the sources in the development system. 

For more information on the required SCAs for each release, you can check SAP Notes 1465468, 
1463541 and 1457908. 

Note 

If you use the transport of sources, the libraries must be available in all buildspaces in CBS. 
Therefore, you must execute the Synchronize Service for any system (development 
configuration) that is part of your system landscape. 

To synchronize your NWDI with the runtime system concerning the SCAs required / to be developed, 
proceed as follows: 

1. Make sure that all required SCAs that you need are available – those that are delivered by SAP 
and on which your development depends and those that you would like to develop. Copy them to 
a folder on your NWDI. 

Note 

You can get the SCAs delivered by SAP from the Installation / upgrade folder of your 
runtime system. 

2. Start the Synchronize Service. You can do so using the related links in the development 
configuration service. Go to Related Links → Synchronize Service. 

 

http://service.sap.com/sap/support/notes/1465468
http://service.sap.com/sap/support/notes/1463541
http://service.sap.com/sap/support/notes/1457908
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3. A new window showing the Synchronize Service opens. Select your development configuration – 
DEV in our example. 

 
4.  In the System State table, you can compare the versions of the SCs that are currently available 

on the runtime system with the ones imported into NWDI. Click Next. 

 
5. Enter the Inbox Path. Name the folder where you stored your SCAs and click Next. 

 
6. Check the Synchronize Software Components table. For every SCA, you will find a 

recommended action in the Actions column. For those that you copied to the folder that you 
named in the previous step, the recommended action will in most cases be to Import Archives. 
For SCAs where there is no SCA available in the inbox, the recommended action will be to Skip 
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the import for this SC. You can change the action if needed. Click Next. 

 
7. On the next screen, you will see a summary. Check this and then click Synchronize to start the 

synchronization. 

 
8. The results of the synchronization are shown in the log below the Summary table. 
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Note 

If you would like to check the log at another point in time or if you closed the Synchronize 
Service, you can always use the History Service to check the logs. 

9. If you now restart the Synchronize Service, you should see that the version in NWDI and in the 
runtime system is now the same. You can ignore the warning shown in last column of the System 
State table that the status of the runtime system is unknown. This is fixed with SAP Note 
1958217. 

 

7.2 Creating Target Systems 

The configuration that was described in the previous chapters is needed for both landscape scenarios - 
source and deployable transport. The configuration of the target systems depends on the scenario that 
you have chosen. In the following chapters, the deployable transport is described in detail. You will find 
notes in those steps where the configuration for the source transport differs. 

In this chapter, we will configure the landscape in a way that you can export deployable units from the 
development system and import them into the test and production system which are pure deployable 
targets. This means that none of the target systems has a development configuration and NWDI must not 
be up and running during import. For the transport of deployables three transport options are possible as 
explained in the chapter Deployable Export. For the development configuration you select the radio 
button Deployable Export as Export Mode in the Development Configuration Service UI and choose 
which granularity you would like to enable for your transport landscape. We have seen this in the chapter 
Configuring the Development Configuration. All other systems along your transport route have to be 
configured as pure target systems with a Java Deploy URL which is explained in more detail below. 

 CAUTION 

A landscape that is configured for deployable transport cannot be used for source transport. 
There are no workspaces and buildspace available to manage the sources on the target 
systems. 

A development configuration is needed for the development system only. It does not matter which option 
of transporting deployables you selected. 

Note 

If you decide to use the transport of sources, you need a development configuration for each 
system. 

Proceed as follows to create a target system: 

https://service.sap.com/sap/support/notes/1958217
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1. In the System Overview in transaction STMS choose SAP System → Create → Non-ABAP 
System. 

 
2. Fill in the following fields: 

• System: SID of your test system 

• Description 

• Select Activate deployment Service and choose the appropriate Method. Enter the Target 
Host and the System No. 

Click on Save. 

 

Note 

If you are setting up a landscape for source transport, choose Create Development 
Configuration as well. In this case, the DI Configuration Service will be shown automatically 
after you finished the configuration for this system. Configure the development 
configuration in the same way as you did for your development system (see chapter 
Configuring the Development Configuration). 
You can use the option Copy Definition From to configure the development configuration. 
Choose your development system as source. 
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Use ACLs to make sure users do not accidentally change sources on the test or productive 
system. Refer to the SAP Library at 
http://help.sap.com/saphelp_nw73/helpdata/en/21/53882f3fee0243b6c774e26ebed880/fra
meset.htm for details. 

3. Enter a user and a password with deploy permissions on the target system. 

 

Note 

For the parameter DEPLOY_WEB_SERVICE, the value CTSDEPLOY is automatically 

entered for each system. This is fine if you transport deployables. If you want to use the 
source transport, you have to change this to CTSDEPLOY_DI. 

 

http://help.sap.com/saphelp_nw73/helpdata/en/21/53882f3fee0243b6c774e26ebed880/frameset.htm
http://help.sap.com/saphelp_nw73/helpdata/en/21/53882f3fee0243b6c774e26ebed880/frameset.htm
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4. To check that the system is configured correctly, click on the button Transp. Tool:  

 
In the result, all the checks should show a green check mark – especially in the sections Deploy 
Web Service and Deploy Tool. 

 
5. Repeat the previous steps for all other target system that you want to use for the landscape. You 

are not limited to a three-system landscape. All the options for designing landscapes that are 
offered by TMS (more than one target system at a time, groups etc.) are available for non-ABAP 
landscapes as well. 

 

7.3 Creating Transport Routes 

The systems that are part of the landscape of the Java runtime systems are now known in CTS. In the 
next step, we have to connect them via transport routes. This configuration is also done in transaction 
STMS. For the configuration of transport routes, it doesn’t matter whether you transport sources or 
deployables. 
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1. Go to transaction STMS and choose Transport Routes. 

 
2. Switch to Change mode. 

 
3. Move the systems DEV, TST and PRD to the lower part. To do so, first click on the system itself 

and then in the free space in the lower part. Click on Add Transport Route: 

 
4. Draw a line from DEV to TST. In the dialog box, choose Consolidation, and enter a Transport 

layer. 
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5. In the dialog box, enter a Short Description and choose Transfer. 

 
6. Choose Transfer. 

 
7. Draw a line from TST to PRD. In the dialog box, choose Delivery and click again on Transfer. 

 
8. Click on Save. 
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9. In the dialog box, enter a Short description and click on Transfer. 

 
10. Click Yes to Distribute and Activate your configuration. 

 

The configuration part is now finished. You can start working with the development configuration. 

 

8 Development and Export Process 
2. In this chapter you can find out how to work with a development configuration that you created 

above using the SAP NetWeaver Developer Studio (NWDS). Furthermore the release process is 
explained. You can learn how an activity is released if CTS+ is in use. The SDA(s) involved will be 
added to a transport request in the format of a DIP (Development Infrastructure package) file. Last 
but not least the SCA export process with the DI Export Service UI is explained. 

Note 

If you plan to develop Web Dynpro Java, you have to make sure that the runtime systems 
and the NWDS are on the same release and SP level. See SAP Note 718949 for details. 
You can nevertheless use the CM Services of SAP NetWeaver 7.3 even if your runtime 
systems are on a lower release. In that case you need an (maybe additional) SAP 
NetWeaver Developer Studio which supports releasing the activities in the transport view. 
For versions of the developer studio which support releasing activities, refer to SAP Note 
1361909. 

3.  

8.1 Import Development Configuration 

4. This chapter explains how to import a development configuration into your developer studio. 

http://service.sap.com/sap/support/notes/718949
http://service.sap.com/sap/support/notes/1361909
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1. Open your SAP NetWeaver Developer Studio. Go to Window → Open Perspective and open the 
Development Infrastructure perspective.  

 

2. To connect your developer studio with the NWDI, go to Window → Preferences. 

 

3. Go to Development Infrastructure → System Landscape Directory. Enter the URL of your SLD 
and click on OK. 
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4. Choose New/Import Development Configuration. 

 

5. Select Import from System landscape Directory (SLD). Click on Next. 

 

6. Enter your User and Password. Click on Log on. 
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7. Choose your Development Configuration – DEV in our example. Click on Next. 

 

8. You will see details of this development configuration. It might be worth checking that the SCAs 
that you want to develop are shown as to be developed (indicated by the yellow icon with the 

pencil ). Click on Finish. 
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9. Enter the User and Password for the NWDI. Click on Log on. 

 

Note 

The User is case-sensitive in here. 

10. In the Component Browser, you can now see the SCAs (and sub-components). For more 
information on development configurations, refer to the SAP Library at 
http://help.sap.com/saphelp_nw73/helpdata/en/49/2aae589c1a1903e10000000a42189c/frameset
.htm. 

 

5. Before an activity can be released for transport, it has to be checked in and activated. These steps 
remain the same compared to a development configuration managed by CMS. The next chapter 
will explain the behavior of the release process for deployable transport. 

 

8.2 Release Activity 

If you want to transport your changes based on an activity, the development configuration needs to be 
configured in that way (see chapter Landscape Options). Here the two options are possible: Activity 
transport on source or deployable level. For the developer it makes no difference in the handling of the 
tools. He will recognize the kind of transport in the window title of the transport view and in the following 
release dialog. 
To release an activity and attach it to a transport request, proceed as follows: 

1. As soon as you finished your development, check in the activity as a first step. This step is the 
same if you use CTS+ or not. In the Open Activities View, right-click on your activity and choose 

http://help.sap.com/saphelp_nw73/helpdata/en/49/2aae589c1a1903e10000000a42189c/frameset.htm
http://help.sap.com/saphelp_nw73/helpdata/en/49/2aae589c1a1903e10000000a42189c/frameset.htm
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Checkin. 

 
2. Enter a name for your activity. 
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Note 
Checking in the activity will also automatically activate it by default. 
You can configure this behavior. If you want to activate changes manually, configure your 
developer studio accordingly.  

 
3. As soon as the activation is finished, you need the Transport View to attach the activity to a 

transport request. Go to Window → Show View → Transport View. 

 
4. Browse for your activity. 
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Note 

If the activity that you just checked-in / activated is not shown under Waiting, check in the 
Activation Requests View whether the activation is still running or whether it failed. 

5. Right click on your activity and choose Release. 

 
6. In the dialog box, you can see the transport request that is currently marked as default for your 

user. If you would like to check details for this request or use a different one, click on the button 
Create/Select. This will open the Transport Organizer. Refer to the chapter Using the Transport 
Organizer Web UI for details. 

 
If you changed anything in the Transport Organizer Web UI, always click Refresh in here before 
you continue. Only if you follow this procedure, the changes done in the Transport Organizer 
Web UI will be taken into account in the further release process. This is especially important if 
you changed the default request. 

 Recommendation 

You can use one transport request to attach several DIPs (activities). This is one option to 
work with a transport request during your development phase. If you use several transport 
requests which contain changes for the same coding (the same SDAs), you should release 
a transport request soon after having attached something. If you attach the same content 
with different changes to more than one transport request and mix the order of releasing the 
requests so that it does not fit with the order in which the changes were done, you can 
create what is called “overtakers” when executing imports. This means that not the latest 
changes will be the active ones in the target systems. 

7. Click on Release rebuilt deployable DCs if the request is the one that you would like to use. You 
can also set the option Monitor Request. This will open the Transport Organizer after the activity 
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has been attached to the transport request. You can then e.g. release your transport request or 
check that the activity was attached to the transport request. 

 
8. After having released the activity, it should be visible in the section Released in the Transport 

View. 

 
The transport request used for a dip file can also be found in its properties: 
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Note 

You can use the icon View Menu in the Transport View to call the Transport Organizer or 
the Export Web UI: 

 

9. You can also check the Object List in the Transport Organizer to check what has been attached 
to the transport request. 
The number of DIP files that are attached to the transport request reflects the number of affected 
software components. 

 
10. Depending on the transport strategy that was configured in TMS, you can now add additional files 

to the transport request or release it in the Transport Organizer Web UI and then import it into 
your target systems. For details on importing transport requests, refer to the chapter Importing a 
Transport Request. For details on the transport strategy, refer to the SAP Library at 
http://help.sap.com/saphelp_nw73/helpdata/en/c5/d9012e437d4c318976edc9791f2ae4/content.h
tm. 
 

8.3 Complex Example 

To explain the advantages of the new activity-based SDA transport the following application example is 
used: There are two software components LANDSCAPETESTSC1 and LANDSCAPETESTSC2 with 
several Development Components and dependencies between them. In the example in the precious 
chapter the Development Component demo 1 was changed. A simple change was done; there were no 
dependent DCs involved. 

We will now take a look at a more complex example to show how dependencies are taken into 
consideration when releasing an activity. 

 

http://help.sap.com/saphelp_nw73/helpdata/en/c5/d9012e437d4c318976edc9791f2ae4/content.htm
http://help.sap.com/saphelp_nw73/helpdata/en/c5/d9012e437d4c318976edc9791f2ae4/content.htm
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In the figure above, you can see two SCs. LANDSCAPETESTSC1 and LANDSCAPETESTSC2. 

LANDSCAPETESTSC1 contains the deployables lib, webui1 and appl1. LANDSCAPETESTSC2 contains 

the deployable appl2. 

LANDSCAPETESTSC1 has dependencies to LANDSCAPETESTSC1. During build time, ejb1 of 

LANDSCAPETESTSC1 is used by ejb2 of LANDSCAPETESTSC2 as you can see in the picture above. 

The result of this is that at runtime, appl2 uses appl1. The same is valid for webui1 which also uses ejb1. 

In the following example, a change to ejb1 will be done. As ejb1 is used by ejb2, ejb2 has to be rebuilt as 

well. Same is valid for webui1. As a result, the deployables app1, appl2 and webui1 have to be 

transported as these three deployables had to be rebuilt because of the change done to ejb1. 

So how does the process look like? The Development Component ejb1 is changed. When the respective 

activity is activated, CBS will rebuild all affected DCs as explained before. Then during release CM 

Services calculates the rebuilt DCs (SDAs) and packs them into DIP-files which are attached to the 

transport request. 

As you can see in the pop-up screen ‚Release for Transport (shown in the following figure), the two 

Development Components appl1 and webui1 of Software component LANDSCAPETESTSC1 and the 

Development Component appl2 of Software component LANDSCAPETESTSC2 were rebuilt 

automatically to ensure a consistent state. 
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In the Transport Organizer Web UI you will find two dip files in the Object List tab – one for each rebuilt 
SCA. One dip file contains apll1 and webui1 of LANDSCAPETESTSC1 and the other dip-file contains 
appl2 of LANDSCAPETESTSC2. 

 

 

8.4 SCA Export and Transport 

Before starting to use the export service, you should have setup a landscape on your CTS system which 
contains all the systems where you would like to import the SCAs. The SCA export and transport is 
possible for both landscape configurations – source and deployable transport – if you set this option when 
configuring the development configuration. 
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Note 

You can add the option to allow SCA exports in addition later on by simply changing the 
development configuration (adding this option). You can also remove it. But you cannot 
switch from deployable to source transport (or vice versa) by simply changing this option in 
the development configuration – target systems are configured in a different way for source 
and deployable transport and would need to be changed as well. 

The way how to use the DI Export Service UI does not differ for source and deployable transport. The 
exported SCA always contains the sources, but the sources will only be used in a landscape that is 
configured for source transport. 

Note 

The export process will take all activated activities into consideration that are related to the 
SCA export. For activities that are listed as ‘Waiting’ in the Transport View of the Developer 
Studio, the export process triggers the automatic release. It will not release open activities. 

Do the following to export and attach SCAs or SDAs to a transport request in TMS via the Export Service 
UI: 

1. Execute the following step a or b to open the DI Export Service UI 
a. On your CTS system, call transaction STMS. In the System Overview, double-click your 

development system (DEV). Choose Development Configuration. 

 
Log on with the user NWDI_ADM. 

b. Open the NWA on your CM Services System (should be the NWDI). Log on with the user 
NWDI_ADM. Go to Configuration → Infrastructure and choose Development 
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Infrastructure. 

 
2. Go to Related Links→ Export Service 

 

Note 

You can also use the menu in the transport view of your developer studio to open the Export 
Web UI. 

You can also create a favorite in your browser for the URL 
http://<host>:<port>/webdynpro/dispatcher/sap.com/tc~di~cts~config~webui/Export 
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3. Select your development configuration, decide whether you would like to use the SCA Export and 
click on Next. 

 
4. Select the SCA(s) that you would like to export and click on Next 

 

Note 

You can also select more than one SCA by holding the CTRL-key while selecting. 

5. On the next screen, you can set some options. Set them according to your needs and click on 
Next. 
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If you have selected export mode SCA Export and the SCAs to be exported are not in the SAP 
namespace, you can define a Patch Name for your export, a Support Package Level and the 
Patch Level. 
You can decide whether sources and archives should be included and set some options in case 
of an error. If you decide not to include sources, then only pointers to DTR will be included. This 
reduces the export time and the size of your SCA significantly. We recommend performing your 
exports without including sources as long as the target system of your transport is located within 
your company. 
The flag “Include Archives” is needed to add the build and deployable archives into the SCA file. 
This is needed in case your landscape is configured for deployable transport. If you include 
sources, the full content of the corresponding workspaces is physically exported. This is only 
required or recommended in case you have to export sources (e.g. for a backup) or if your source 
DTR is not available during import time into another DTR. 

Note 

If you decide to set the Support Package Level, the Patch Level is automatically set to 0. 
You cannot change this. 

6. The next screen shows the transport request to which your SCA will be attached if there is a 
default request available for your user or if the system in TMS is configured to create on 
automatically. If there is no default request available or if you would like to change the one that is 
currently shown, you can use the link Transport Requests to open the Transport Organizer Web 
UI. By the help of this UI, you can create e.g. new requests or make another one your default 
request. If you changed anything in the Transport Organizer Web UI, always click Refresh in the 
Export Web UI before you continue. Only if you follow this procedure, the changes done in the 
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Transport Organizer Web UI will be taken into account in the further process in the Export Web 
UI. This is especially important if you changed the default request. 
If you want to, you can add a note that will be added to the documentation of the transport 
request. 
Click Next as soon as everything is correct concerning the transport request. 

 



  

How To... Configure CM Services in SAP NetWeaver 7.3   

Development and Export Process  © 2025 SAP AG or an SAP affiliate company. All rights reserved. 80 

7. On the next screen, you can see a summary of the settings that you did in the previous steps. 
Click Export if everything is ok. 

 
8. Depending on the transport strategy that was configured in TMS, you can now add additional files 

to the transport request or release it in the Transport Organizer Web UI and then import it into 
your target systems. For details on importing transport requests, refer to the chapter Importing a 
Transport Request. For details on the transport strategy, refer to the SAP Library at 
http://help.sap.com/saphelp_nw73/helpdata/en/c5/d9012e437d4c318976edc9791f2ae4/content.h
tm 

 Recommendation 

You can use one transport request to attach several SCAs. This is one option: work with the 
same transport request for your development phase. If you create several requests which 
contain different versions of the same SCA, should release a transport request soon after 
having attached something. If you attach the same SCA to more than one transport request 
and mix the order of releasing the requests so that it does not fit with the order the SCAs 
were created, you can create what is called overtakers when executing imports. This means 
that not the latest changes will be the active ones. 

9. After the export has finished successfully, the export log is shown in the section Export Log. 

http://help.sap.com/saphelp_nw73/helpdata/en/c5/d9012e437d4c318976edc9791f2ae4/content.htm
http://help.sap.com/saphelp_nw73/helpdata/en/c5/d9012e437d4c318976edc9791f2ae4/content.htm
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Note 

You can also use the Export Service UI to attach SDA(s) to a transport request. The 
process is very similar – with the exception of setting versions and patch level – this only 
exists on SCA level. 
SDA is only possible in case of deployable export and only if you set this option when 
configuring the development configuration. 

 

 CAUTION 

The SDA export is only made for experts. Only the SDAs that you choose will be 
attached to the transport request. There are no dependencies taken into 
consideration. There is therefore a risk that you break the target system when 
importing the request in the target system if dependent SDAs that were also changed 
are missing in the import. The version that is currently active in CBS is attached to the 
transport request. 

 

 

9 Troubleshooting 

9.1 Error during Import / Deployment (RC 12) 

1. The import into the target system stops with return code 12 and error message “Connect to 
message server host failed”. 

 
 
Reason:  
The parameter CTS_FILE_PROVIDER_URI is in use and the communication system (CTS ABAP 
stack) is not maintained on the system where your Deploy Service is running (here: NWDI 
server). 
Solution: 

• On your Java stack system where the Deploy Service is running go to 

C:\WINDOWS\system32\drivers\etc and open the file Services with an editor (for 

example, Word pad). 

• Check if the sapms<SID> entry exist and if the port is correct. If not, correct them. For 

more information, see SAP Note 1155884. 

• Restart the import. 

The import into the target system stops with return code 12 and error message 

“DIImport_CommunicationException: Cannot read development configuration of system…”. 

http://service.sap.com/sap/support/notes/1155884
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Reason 

Wrong Deploy Web Service is in use – you would like to use source transport but forgot to change 

the Deploy Web Service to CTSDEPLOY_DI which points to your NWDI. 

Expand the log to see which deploy web service is used 

 
In here, you should see your NWDI server (in our example, CTJ is the AS Java of the CTS system, 

the NWDI is named DN5 and this is expected to be used in here for source transports)  

Solution  

Change the parameter DEPLOY_WEB_SERVICE in TMS to CTSDEPLOY_DI. Check also SAP 

Note 1453836 

9.2 Import seems to run forever 

In case your import of the transport request into the target system seems to run forever and your Target 
System has a DI Configuration, you should check the following: 

Open the History Service and check the current status of your import. If the import stopped at the step 
‘Build Server Import’, check if CBS is started and works properly. Open the CBS Web UI via 
http://<host>:<port>/webdynpro/dispatcher/sap.com/tc.CBS.WebUI/WebUI. Choose Requests, select the 
From Date and To Date for your Buildspace accordingly to search (Search button) for all Requests since 
the CBS was installed and initially configured. You should see at least an entry with the Request Type 
INIT_COMPARTMENT and the Request State SUCCEEDED. In case the Request State is set to 
QUEUED you should check the parameter idleStart.  

To do so, open the NetWeaver Administrator on your NWDI (http://<host>:<port>/nwa) and go to 

Configuration → Infrastructure → Java System Properties. Select your node and open the tab Services. 
Choose Component Build Service → Modify IdleStart. 

http://service.sap.com/sap/support/notes/1453836
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9.3 Activity cannot be released 

When you try to release an activity in the developer studio, you receive an error message: ‘No successful 
activation request found for activity…’  

Refer to SAP Note1909778 for possible reasons and solutions. 

 

10 Appendix 

10.1 Using the Transport Organizer Web UI 

The Transport Organizer Web UI is made for creating, changing or releasing transport requests on the 
CTS+ system. Depending on the release of your CTS+ system and whether CTS_PLUG is installed or 
not, you can find different versions of this UI. If you would like to use the new Transport Organizer, you 
have to use a CTS+ system with CTS plug-in 2.0 on SAP Solution Manager 7.1, SAP NetWeaver 7.31 or 
7.4. 

The Transport Organizer Web UI delivered with CTS Plug-in 2.0 looks like shown in the following figure: 

http://service.sap.com/sap/support/notes/1909778
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More information is available in the SAP Library at 
http://help.sap.com/saphelp_ctsplug20sm71/helpdata/en/df/7a1d1a4f0d4805b46c61a0d53cb4c7/content.
htm  

10.2 Importing a Transport Request 

After you have exported your activities, you might want to import the changes into the test system (TST). 

Before you can do so, you have to release the transport request. This is done in the Transport Organizer 
Web UI. Mark your request and click on Release. 

 

Note 

Depending on your configuration, it might also be that the request is released automatically 
after something was attached. If this is the case in your landscape configuration, you can 
skip this step. Nevertheless, you can use the Transport Organizer Web UI to make sure that 
your activity (the respective SDA) is attached to the transport request and that it was 
released. 

To import the transport request into the system TST do the following: 

http://help.sap.com/saphelp_ctsplug20sm71/helpdata/en/df/7a1d1a4f0d4805b46c61a0d53cb4c7/content.htm
http://help.sap.com/saphelp_ctsplug20sm71/helpdata/en/df/7a1d1a4f0d4805b46c61a0d53cb4c7/content.htm
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1. Log on to your CTS+ System, open transaction STMS and click on Import Overview 

 
2. Double-click on the system where you would like to import a request 

 
3. You can now either import all requests that are in the queue or import a single request. To import 

one request, mark it and click on Import request 
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Note 

If the request that you just released is not visible, click on Refresh. 

4. Set the import options according to your needs and click on Continue 

 
5. Confirm that you would like to leave the request in the queue (only if you import not the complete 

queue) 

 
6. Click on Refresh until the import is finished. The column RC should show a green square. 
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7. You can also check the status for a certain request in the Transport Organizer Web UI on the tab 
Logs. 

 

10.3 Extending the Landscape 

In this chapter, we will give you some insights on how to extend the landscape that you configured before. 
What is covered in here is adding e.g. an additional test system. The procedure described in here cannot 
be used for adding a new development system. Exchanging the development system (the SID in TMS) 
would mean that the transport requests in CTS will get a different naming etc. Existing transport requests 
that were not released cannot be used any more. So we do not recommend exchanging the development 
system. 

In case you need to extend your landscape, you have to make sure to import previous transport requests. 
For a system landscape that is enabled for source transport (= target systems with development 
configurations) it is essential to make sure that the required libraries are also imported into NWDI for the 
new system (buildspace). Use the Synchronize Service to do so. 

After having extended the landscape, you should make sure that you add all transport requests to the 
new system that were already imported into the following system or that you create a new transport 
request on the development system which contains the SCA(s) that you develop and transport this 
request through the complete landscape. This would make sure that you have a consistent state of your 
application available in all systems involved. 

We assume you created your new non-ABAP target system with or without development configuration as 
described before. In addition the required transport routes are available. The next steps explain how to 
import transport requests (that have been already transported) to this new target system. For all 
upcoming transports this new target system will be delivered via the regular transport route. 

1. On your CTS system, call transaction STMS. In the System Overview, select the system to which 
you want to add a transport request 

2. Choose Extras → Other Requests → Add. 

 
3. Enter the transport request with the required files and choose Ok. The request has been added to 

the queue and can be imported. 

 



  

How To... Configure CM Services in SAP NetWeaver 7.3   

Appendix  © 2025 SAP AG or an SAP affiliate company. All rights reserved. 88 

4. Select your requests in the import queue and import them 

 
5. Repeat these steps for all new systems in your landscape 

 

 

10.4 Configure Users on CM Services server 

If you would like to run the CM Services on a server where no NWDI component is used so far, you can 
execute the functional unit CM Services. In case the users NWDI_CMSADM, NWDI_ADM and 
NWDI_DEV already exist, the FUN will ask you whether you would like to overwrite the password. Make 
sure that the same password as on the NWDI system is used. 

For more information on configuring the NWDI, refer to the SAP Library at 
http://help.sap.com/saphelp_nw73/helpdata/en/b4/d347306670474e8ef8771ef989922e/content.htm?fram
eset=/en/53/75b3407e73c57fe10000000a1550b0/frameset.htm  

Note 

If you decide to do the configuration manually and use other users than the ones that the 
FUN would create, you have to make sure that they exist both on the NWDI system and 
on the CM Services server. 

 

10.5 Using Build Options 

If you would like to use your NWDI to develop java applications for more than one SAP NetWeaver 
release, you can use Build Options to do so. 

As a prerequisite, you have to prepare CBS to be able to use different jdks during the build. For details, 
take a look at 
http://help.sap.com/saphelp_nw73/helpdata/en/53/75b3407e73c57fe10000000a1550b0/frameset.htm  

Starting with enhancement package 2 for SAP NetWeaver 7.0, CM Services support build options. When 
configuring your development configuration, you can specify which jdk should be used. This can be done 
by entering com.sap.jdk.home_path_key as Build Option Name and e.g. JDK1.3.1_HOME as Build 

Option Value. The Value has to exist in CBS in the property JDK_HOME_PATHS. 

For more information on CBS Service Properties, refer to 
http://help.sap.com/saphelp_nw73/helpdata/en/b5/7a5e4088dc0272e10000000a155106/frameset.htm  

 

http://help.sap.com/saphelp_nw73/helpdata/en/b4/d347306670474e8ef8771ef989922e/content.htm?frameset=/en/53/75b3407e73c57fe10000000a1550b0/frameset.htm
http://help.sap.com/saphelp_nw73/helpdata/en/b4/d347306670474e8ef8771ef989922e/content.htm?frameset=/en/53/75b3407e73c57fe10000000a1550b0/frameset.htm
http://help.sap.com/saphelp_nw73/helpdata/en/53/75b3407e73c57fe10000000a1550b0/frameset.htm
http://help.sap.com/saphelp_nw73/helpdata/en/b5/7a5e4088dc0272e10000000a155106/frameset.htm
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You can define additional build options. Refer to 
http://help.sap.com/saphelp_nw73/helpdata/en/bd/cddf4164ee6024e10000000a1550b0/frameset.htm for 
details. 

 

10.6 Checking Role SAP_CTS_PLUS 

In older releases, it might be that some permissions are missing in the role SAP_CTS_PLUS. Do the 
following to fist check the role and then create one which contains the required permissions. 

1. Open transaction PFCG and display the role SAP_CTS_PLUS. 

 

http://help.sap.com/saphelp_nw73/helpdata/en/bd/cddf4164ee6024e10000000a1550b0/frameset.htm
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2. On the Authorizations tab choose Display authorization data: 

 
3. Make sure that the following permissions are available: 

 
Authorization Check for ICF Access (object: S_ICF): 
ICF_FIELD: DEST, PROXY, SERVICE 

ICF_VALUE: * 
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Authorization Check for RFC Access (object: S_RFC): 
RFC_NAME: CTS_WBO_DIS, EPSF, RFC1, SDIFRUNTIME, STPA, SYST 

RFC_TYPE: FUGR 

Administration Functions in the Change and Transport System (object: S_CTS_ADMI): 

CTS_ADMFCT:  EPS1, EPS2 

Authorization for file access (object: S_DATASET): 

ACTVT:  06, 33, 34, A6, A7 

FILENAME: * 

PROGRAM:  CL_CTS_ASSIST_BROWSER=========CP, SAPLEPSF, SAPLSCTS_EXE_FILE, 

SAPLSCTS_RELEASE, SAPLSLOG, SAPLSTFI, SAPLSTPA, SAPLSTPP, SAPLSTRF, SAPLTMSM, 

SAPLTMST 

Transport Organizer (object: S_TRANSPRT): 
ACTVT: 01 (Create or generate), 02 (Change), 03 (Display), 05 (Lock), 06 (Delete), 23 (Maintain), 43 

(Release), 50 (Move), 60 (Import), 65 (Reorganize), 75 (Remove), 78 (Assign), 90 (Copy) 

TTYPE: CUST, DTRA, PIEC, TRAN 

4. If not all necessary values are assigned to role SAP_CTS_PLUS, copy this role.  

 
5. Name the new role Z_CTS_PLUS, and choose Copy all. 

 
6. Enter a description and click on Propose Profile Name to get an automatically generated profile 

name. Save your entries. 
7. Click on Change Authorization Data and assign all missing necessary values. Go one step back (F3) 

and save your entries. 
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8. On the User tab page, click on User Comparison and then on Complete comparison 

 
9. Assign this newly created and activated role Z_CTS_PLUS to user NWDI_DEV. Remove the role 

SAP_CTS_PLUS 

 

 

10.7 SIDs in CM Services 

If the SID is already used, you can also use any 3 letter name that has not yet been used in the domain. It 
is not required that the runtime systems are shown in CTS by their real SID in case of CM Services – but 
it simplifies keeping an overview if you do so. 

10.8 Creating a new SC 

If you would like to create a new SC to develop your own functionality, you can do so from within the 
Development Configuration service. The following steps have to be executed: 

1. Open your development configuration e.g. from within TMS. 

 
2. In the Development Configuration Service, open the Software Component Definition tab and click 

on Add SC 

 



  

How To... Configure CM Services in SAP NetWeaver 7.3   

Appendix  © 2025 SAP AG or an SAP affiliate company. All rights reserved. 93 

3. In the pop-up, choose Create New Software Component 

 
4. Enter a user and password (and the SLD URL if not automatically filled in) and click on Next. 

 
5. Enter the details for your SC: a Name, a Vendor, and a Release. Click on Next 
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6. Define the application template: click on the drop down 

 
7. In the pop-up, choose the release of your runtime system. 

 
If the template for your runtime system is missing, you can also execute the wizard for creating a 
new SC on another AS Java of your choice – it doesn’t matter whether NWDI is installed on the 
system or not. E.g. use AS Java you want to develop for. 

Note 
The wizard is always started on SLD. If you would like to start it on a different server, use 
the URL: 
http://<server>:<port>/webdynpro/dispatcher/sap.com/tc~lm~ctc~ccl~template_in
staller~wd/TemplateInstaller?processPath=content/DefineSCV/processes/DIDefine
NewSoftwareComponentVersion.cproc&processComponent=sap.com/tc~di~ctc~con
tent&batchExecution=true  
or open the NetWeaver Administrator of the respective system and open Configuration → 
Scenarios →-Configuration Wizard → Define New Software Component Version Details 
are available in the SAP Library at 
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http://help.sap.com/saphelp_nw73/helpdata/en/02/369c8b606341a3b1d3b1e05259fcd3/fra
meset.htm 

8. Click Next. 

 
9. The new SC is now defined. Close the window 

 
10. The list of SCs that can be added to the development configuration is now visible again. Click 

Refresh to make the SC that you just created part of the list and mark it to add it to the 
development configuration. 

 

10.9 Enable existing non-ABAP system for CM Services 

If you already have a non-ABAP system landscape in place for e.g. your SAP Enterprise Portal or SAP 
Process Integration Systems, you can easily extend this system landscape so that you can also transport 
your NWDI-based Java development through this landscape. There is no need to create a separate 
landscape based on invented SIDs in this case. Do the following to add a development configuration to 
your existing non-ABAP systems. Some of the following steps apply to all systems, some only to source 
systems and some only to target systems. You will find an appropriate remark in each step. 

http://help.sap.com/saphelp_nw73/helpdata/en/02/369c8b606341a3b1d3b1e05259fcd3/frameset.htm
http://help.sap.com/saphelp_nw73/helpdata/en/02/369c8b606341a3b1d3b1e05259fcd3/frameset.htm
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1. Log on to your CTS system, start the transaction STMS and go to the System Overview. 

 
2. In the System Overview, double click on the system where you would like to add the option to use 

CM Services of your transport route, switch to the tab Transport Tool and switch to Edit mode. 

 
 

3. Click on one line and then on Insert Row. 

 
 

4. For the source system and all systems where you like to import sources: Open the F4 help in 

your new line and add the parameter DI_SYSTEM. Add TRUE as value. 
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5. For the source system and all systems where you like to import sources: Repeat the two previous 

steps to add the parameter DI_SLD_URL. If this is the first DI-System that you create in your 

CTS System, add the URL of your SLD where the Development Configurations have to be stored 

and make sure that the parameter DI_SLD_URL is marked as Global. If you used this parameter 

before, it might be the case that it is already in the parameters’ list of your system. 

 CAUTION 

The DI_SLD_URL parameter is a global parameter. It can only be defined once in your CTS 
system. The same SLD has to be used for all Development Configurations. 

6. Configure the deploy web service as described in chapter Configuring RFC Destination and 

Logical Ports 

7. For target systems where you would like to import sources: Repeat steps 3 and 4 to add the 

parameter DEPLOY_WEB_SERVICE. Use the name of the deploy web service that you created 

in the previous step (e.g. CTSDEPLOY_DI) as value. 

Hint: The destination, e.g. CTSDEPLOY_DI, needs to point to the server where CM Services and 

CTS Deploy WS are running. 

8. Repeat the steps 3 and 4 to add the parameter DEPLOY_CONFIG_DI. Add the value 

CTSCONFIG. 

9. For all target systems: Check if the parameter DEPLOY_URL already exists (if you extend an 

existing SAP Enterprise Portal landscape, this should be the case). If the parameter is not yet 

available, repeat step 3 and 4 to add the parameter DEPLOY_URL. Insert the deploy URL of your 

system as value following the schema http://<host of target system>:<5<system 

number>18> if your system is on a release below SAP NetWeaver 7.1. If you are using SAP 

NetWeaver 7.1 or above follow the schema http://<host of target system>:<5<system 

number>04>. Instead of using http you can also use P4 or SDM as protocol. When deployment 

should be done over secure P4 connection, https or P4S can be used but then also the port must 

be P4S port. Refer to 

http://help.sap.com/saphelp_nw73/helpdata/en/5d/b9fc64dd82414c90c72a8c26a9f17b/content.ht

m?frameset=/en/5d/b9fc64dd82414c90c72a8c26a9f17b/frameset.htm for details. 

10. For all target systems: Go to the menu path Goto  → SDM/DC User/Password and enter the 

password for the SDM or user and password if you are using a runtime system e.g. on SAP 

http://help.sap.com/saphelp_nw73/helpdata/en/5d/b9fc64dd82414c90c72a8c26a9f17b/content.htm?frameset=/en/5d/b9fc64dd82414c90c72a8c26a9f17b/frameset.htm
http://help.sap.com/saphelp_nw73/helpdata/en/5d/b9fc64dd82414c90c72a8c26a9f17b/content.htm?frameset=/en/5d/b9fc64dd82414c90c72a8c26a9f17b/frameset.htm
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Composition Environment or SAP Process Integration or any NW AS JAVA with Release >= 7.10 

where the Deploy Controller is used instead of SDM. 

11. Only for the very first DI system that you create: Go to the menu path Goto  → Development 

Infrastructure  → DI Service User/Password and enter the user that you created when executing 

the appropriate steps in the guide (e.g. NWDI_CMSADM) and his password. 

12. Only for the very first DI system that you create: Go to the menu path Goto  → Development 

Infrastructure → DI SLD User/Password and enter the user that you created when executing the 

appropriate steps in the guide (e.g. NWDI_CMSADM) and his password. 

13. Save your changes and distribute the configuration. 

14. For all systems: update the configuration service after you did your changes. Choose Goto → 

Development Infrastructure → Update Configuration Service to do so. 

 
(For all cases were this manual trigger is needed see SAP Note 1807994) 

15. Adapt all the target systems of your java landscape 

• Exchange the value for DEPLOY_WEB_SERVICE for all systems where you would like 

to import requests containing activities/sources. 

• Add the parameter DI_SYSTEM (with the value TRUEe to every system where the 

activities/sources have to be imported. 

16. For all systems where you need a Development Configuration: Go back to the System Overview. 

Double click on the respective system. Click on the button Development Configuration. 

 
 

17. The service for maintaining your Development Configuration comes up. Maintain it as described 

in the guide in chapter Configuring the Development Configuration. 

If you need a development Configuration for all systems because you plan to transport sources, 

you can copy the development configuration that you created for your development system. 

18. Repeat the previous step for all other systems where you added the parameter 

DI_SYSTEM=TRUE. 

19. Use the Synchronize Service to provide the required SCAs to all systems where you created a 

development configuration. 

20. Optional and only if you created development configurations for each system in your landscape: 

protect the workspaces of Test and Prod systems via ACLs if you would like to ensure that no-

one does changes in Test or Prod directly. More information is available on the SAP Help Portal: 

http://help.sap.com/saphelp_nw73ehp1/helpdata/en/4c/5fbf43f8da4a3ce10000000a15822b/frame

set.htm  

 

 

http://service.sap.com/sap/support/notes/1807994
http://help.sap.com/saphelp_nw73ehp1/helpdata/en/4c/5fbf43f8da4a3ce10000000a15822b/frameset.htm
http://help.sap.com/saphelp_nw73ehp1/helpdata/en/4c/5fbf43f8da4a3ce10000000a15822b/frameset.htm
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10.10 Deleting a system with Development Configuration 

Deleting the system in TMS is not enough. This will neither delete the development configuration in SLD 
nor the Workspaces or the Buildspace. Refer to SAP Note 1869748 for details. 

 

 

 

http://service.sap.com/sap/support/notes/1869748
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